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Welcome

Congratulations on the purchase of a new Windows Mobile™-based Pocket
PC Phone. The integrated wireless voice and data capabilities mean that as well as
keeping your important PIM information up-to-date and close at hand, you can make
calls, send and receive e-mail, and look up valuable information from the Internet or
your company’s network anytime, anywhere. Also, with Microsoft® ActiveSync®
the power of your device is increased by allowing you to synchronize the information
on your PC with your device.

Before getting started to use and explore your new device, some warning notes here
are very important for you to get through.

Warnings! Please Read Before Operating your Device

d THE DEVICE IS NOT CHARGED WHEN YOU TAKE IT OUT OF THE
“ BOX. (For information, see Chapter 1 : Getting Started)

; DO NOT REMOVE THE BATTERY PACK WHEN THE DEVICE IS
&V cHArGING.

WHEN INSERT A SIM CARD, MAKE SURE THE DEVICE IS TURNED
OFF THEN CLICK IT INTO PLACE. (For more information, see
Chapter 3 : Using Your Phone)

IN MANY COUNTRIES YOU ARE REQUIRED BY LAW TO TURN OFF
YOUR PHONE WHEN YOU FLY. TURNING OFF YOUR POCKET PC
DOESN’T TURN OFF YOUR PHONE; YOU MUST TURN OFF YOUR
WIRELESS CONNECTION TO YOUR OPERATOR’S NETWORK.

YOUR WARRANTY IS INVALIDATED IF YOU OPEN OR TAMPER
WITH THE DEVICE’S OUTER CASING. (For more information, see
the enclosed warranty information)
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1.1 Knowing Your Device

'S Front, Top and Left Side Panel Components

MMC/SD cards or SDIO
accessories slot

Insert either MMC/SD cards or
SDIO accessories in this slot.
Infrared port
Enables you to exchange file(s)
or data with other devices
without cables/ wires.

Contacts Speaker
Press for quick access to your

Power Button/Backlight
Press to turn your pocket PC or backlight
on or off.

Notification LED
See the description
on opposite page.

(-" Listen to audio media or a
Contacts. phone call from here.
Record : Calendar
Press to record a voice note. Press for quick Calendar

access.

Volume
Press up/down to adjust the
volume of your device. Touch Screen
For handwriting, drawing
or for making a selection

with the stylus.

Camera
Press to launch camera
capture utility. Press again
to take a picture.

End

Press to end a call.

Soft Reset
Press into the hole with the
stylus to reset your device. ——=

Send Navigation Pad
Press to answer an incoming Press to move up/down and left/right
call or to dial a number. through any of the drop down menus or
program instructions; select by pressing in

. the center. When in the dialer screen :
Microphone Left - Press once to access the Speed
Speak here when receiving or Dial feature.
making a phone call or voice Right- Press once to access the Call Log

recording. feature.
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S Back, Bottom and Right Side Panel Components

Camera Lens

Stylus and Stylus Slot

Car Antenna

Connector
If available, you can attach
your phone to its antenna and

utilize its superior reception
quality.

Notification LED
Bi-color LED on the right :

For GSM standby, GSM
message, GSM network status,
PDA notification, PDA charging
status.

Blue LED on the left :

For Bluetooth system notification
of powered-on and ready to
transmit RF signal.

Preview Mirror

Back Cover

Fixing Lock
Press to release the back
cover.

Soft Reset
Press into the hole with the
stylus to reset your device.

—— Earphone Jack
Allows you to listen to audio
media or use the phone's

hands-free kit.

Sync Connector
Use this connector when
synchronizing / transmitting data
or recharging.
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1.2 Battery

& Warning : To reduce risk of fire or burns, do
not disassemble, crush, puncture, short external
contacts, heat above 100 (212 ), or dispose
of in fire or water. Replace only with manufacturer
specified batteries. Recycle or dispose of used ﬁ,

batteries to the local regulations. LHen

Your Pocket PC Phone contains a rechargeable Li-ion poly-
mer battery under the back cover. Battery power depends on
whether you are talking on the phone, using the PDA functions
or if the device is on standby.

Battery life estimates :

B Talk-time : 2 ~ 4 hrs,

B PDA : 13 hrs (approx.),

m  Standby : 150 ~ 170 hrs (approx.),
B Data retention time : 72 hrs.

The above times are based on using one function at a time,
interchanging between functions will vary the battery life.

Data Retention

Itis vital to keep your battery charged. Because your Pocket
PC does not have a hard drive, all data and any new programs
you install are stored in RAM. If the battery completely drains
any data or new programs you installed will be erased. Only
the default programs on the device when you bought it will
remain.

To prevent this kind of data loss, a portion of the main battery m

will keep your data safe for 72 hours if your device runs out of
power. An additional battery, the backup battery, is designed
to keep your data safe when you remove the main battery. It @ == i (n
will keep this data safe for 20 minutes.

[ — [
WARNING : BE SURE TO CHECK THE BACKUP . e
BATTERY POWER REMAINS AT LEAST AT

50% OR ABOVE BEFORE YOU REMOVE THE e [

MAIN BATTERY BY TAPPING [if] — Settings e
— System tab — Power R
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To recharge your device

You can recharge your device in the following ways :

o
o> o Place your Pocket PC Phone in the cradle and
connect it to an external power source with the
AC Adapter. Before using your Pocket PC,

charge the battery for at least 8 hours for the 4

first time. Then, place it in the cradle for a short

time each day to recharge it to its full capacity. 3
AC Adapter plugs
into the back of the
cradle

To your Pocket

@ Plugthe AC adapter into the optional USB/Serial PC Phone
cable head and then connect your Pocket PC ¥ USB synchronization
Phone directly to an external power source. L cable, connect to

Plug the AC adapter
into a socket

e Plug the AC adapter into the optional AC Adapter
Converter and then connect to sync connector < HH& -I
of your Pocket PC Phone directly to an external r " ® T

power source without using the cradle. To the sync To AC adapter

connector of your
Pocket PC Phone

o If you have spare battery for your Pocket PC
Phone, you can also put the battery into the slot
in the cradle for recharging.

Put an spare
unit into

the slot for
recharging

AC Adapter plugs
into the back of the
cradle
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When Your Battery is Low

When the low battery-warning message appears, immediately
save any data you are working on, perform a synchronization
with your PC, then turn off your Pocket PC. If your device
does shut down, the backup portion of your main battery will
protect data for about 72 hours.

To view the battery status:

F‘ Tap ES - Settings — System tab — Power.
ALWAYS TO KEEP THE POWER STATUS OF
THE BACKUP BATTERY REMAINS AT LEAST
AT 50% OR ABOVE.

Accessories

USB/Serial Cradle

Your Pocket PC Phone comes with a USB cradle. This allows
you to recharge your Pocket PC Phone with the AC Adapter,
as well as synchronize information between your Pocket PC
and a PC using ActiveSync.

GPRS will not work when your device is plugged
into the cradle.

To synchronize the USB Cradle must be plugged
into an available USB port on your PC.

For battery recharging, you must plug the AC
Adapter into the back of cradle.

An optional cradle with Audio output is available,
please contact your operator/dealer for the
purchase.

QO QL

o ——
- bl b L
- iy
@N (=" ]
[T —— [T

Fiad ia-!l-l-]
Bl s L T WL T L e
g prpy w £ s e paa

Audio output is
available in an
optional unit.

AC Adapter plugs into
the back of the cradle for
battery recharging
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AC Adapter Converter
AC adaptor converter in combination with the AC adapter I vq M -
allows you to recharge your device without the cradle. N L

USB/Serial Sync cable

The USB/ Serial cable allows you to synchronize _
with your desktop without the cradle. The DC con- %\
verter in the head also allows you, in combination ~—

with an AC adapter, to recharge your device. ~—_ USB Cable

Stereo headset

The stereo wired headset has a volume control jog dial
and buttons to pick up and hang up incoming and outgoing
calls.

Backpack (Optional)

This optional backpack is an expansion pack for CF cards
type | and Il and VGA/TV output. The CF expansion card is
a most popular interface card currently on the market. It can
support a VGA/CRT output for a Microsoft Powerpoint presen-
tation or Mirror image from the LCD display of your device. For VGAITV

output
For CF and VGA/TV applications, the Backpack has a built- AN
in extended battery. This extended battery will recharge the Insert your
main battery when attached. CF card here.

u A Backpack tab will be available by tapping m
— Settings — System tab — Power once you

have attached an optional backpack unit on your ‘e s e
device. o

Resolution supports

B For LCD display : XGA 1024x768, VGA 800x600 and
640x480. ] ] s

Sl TN e O T e -

B For TV output: 640x480 NTSC and PAL system. - gy gy w7 o e
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To attach the backpack:

D&) o Remove the back cover.

9 First slot the hooks at the top of
the pack into the device, similar
to with the back cover.

@ Hold in the grey buttons on the
side of the pack and gently push
down so that the connector
clicks into place.

o To remove press the side buttons and pull up.

VGA/TV Adapter
The VGA/TV adapter allows you to play video and presenta-

tions through your computer (VGA socket), or TV (Video and
S-Video).

To attach the cable:

Q
S @ Attach the VGA/TV head to your device
(backpack).

9 For VGA attach the VGA/TV adapter directly
into your computer or projector. For TV plug an
S-Video or Video Output cable into the relevant
socket then into the back of your TV. VGA

Output

S-Video
Output

For VGA/TV
output
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2.1 Starting Up

Screen tapping, Calibration and
Re-calibration

When you first start up your Pocket PC Phone, you will be
asked to calibrate the screen by tapping the center of a cross
with your stylus as it moves around the screen. This process
ensures that when you tap the screen with your stylus the item
tapped is activated.

If your device does not accurately respond to screen taps, you
will need to re-calibrate it.

To re-calibrate the screen :

[a} o Tap H — Settings — System — Screen.

9 As described above, tap the center of the cross to
with your stylus as it moves around the screen.

Today Screen

The Today screen displays important information, such as
today’s appointments and status icons for your device. Tap
the information listed on the Today screen to open the asso-
ciated program.

[a} Access the Today screen by tapping E — Today.

To customize the Today screen display, including the back-
ground image, tap Today at the top of the Today screen or
tap — Settings — Personal tab — Today.

i M e ek L e
i e s e The
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’EI

60 00000000

Tap to go to a program. 0 9 9 0 0
Tap to view notification information. e rr
Tap to view network status and options. 0 )

Tap to change volume or mute all sounds. ,—{

Tap and hold to change time format.

Tap to change date and time.

Tap to change owner information.

Your day at a glance. Tap to open the associated
program

Tap to create a new item. o _
Tap to disconnect from ActiveSync %EI or @
Bluetooth ﬂ

Indicators
Following are some of the status icons you may see.

Indicators Meaning

= Turns all sounds on and off.

Main battery low.

2
8o
o =
83
~ Q
<

o
n:
£

Main battery very low.

Connection is active.

Synchronization is beginning or ending.

Synchronization is occurring.

Notification that one or more instant messages were received.

Notification that one or more mobile e-mail / SMS messages were received.

I b & @ b T

Indicates the connection to your mobile phone service provider is on and the
strength of the signal.

Indicates your phone is switched off.

If more notification icons need to be displayed and there is no room to display
them, this indicator will display. Tap the icon to view all notification icons.

|59
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Programs

B You can switch from one program to another by selecting
it from the E menu. To access some programs, tap E
— Programs, and then the program name.

B The following table contains a partial list of programs that
are on your device. Look on the Pocket PC Companion
CD for additional programs that you can install onto your
device.

[ofo]] Program Description
ﬁ ActiveSync Synchronizes information between your device and PC.
E Calendar IKe%eu%Ssttsr?Ck of your appointments and creates meeting
- F? Contacts Keeps track of your friends and colleagues.
ég = Inbox Sends and receives e-mail/ SMS messages.
£8 P I owhioads now Droorams and Hies from the Intemer.
§ § Notes iCr)]g-:‘Sa'ltes handwritten or typed notes, drawings, and record-
- Phone Makes and receives calls, switches between calls and sets
up conference calling.
Tasks Keeps track of your tasks.
Windows Enables the multimedia function on your Pocket PC

Media Player  Phone.

Pocket Excel Creates new workbooks or view and edit Excel work-

& ¥ WD~ 0D %E

books.
Pocket Word Creattes new documents or view and edit MS-Word docu-
ments.
MSN Sends and receives instant messages with your MSN Mes-
Messenger senger contacts.
Microsoft Collects and reads e-Books on your device.

=

Reader
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B You can also switch to some pro- ¥ m
grams by pressing a program but- L y E E
ton. Your device has one or more | . & T P e
program buttons located on the front i : o
or side of the device. Theiconson | E# 47 T W e i s
the buttons identify the programs | #==== [ imiem =ememn = - L
they turn on . For more information ¥ 8 W\ [ o4 A
about the Button settings, please | . L - | gy e 1
see Chapter 5. Compmer Spweyn Culsis L

o v| &S
i kel = ‘::" By =
o -
Icon Program Description
i@ Ccamera Snaps photos or shoots video clips with accompanying
audio.
Album Collects, organizes and sorts .JPG/.BMP/.GIF picture files

on your Pocket PC phone from Camera or ActiveSync.

|'l"-'} Photo Input the image files according to your Contacts list and b
- Contacts set up the Caller-ID function L) g
(=]
3{_} MMS Send and receive MMS messages. % §
]
Q
E Calculator Performs basic arithmetic, such as addition, subtraction, ;.<
multiplication, and division. 0 g
H;j Games Two games, Jawbreaker and Solitaire are included in this =
) folder by default.
Ha Wireless Enable your device as an external modem for a PC or
s Modem Notebook by using a serial/USB port, or infrared.
& SIM Collects, organizes and sorts the Contacts list stored in
Manager your SIM card.
m xBackup Back up your Pocket PC Phone files to ROM or an SD
card
[ Pictures Collects, organizes and sorts .jpg picture files on your

Pocket PC phone or on a storage card.
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Navigation Bar and Command Bar

The navigation bar, located at the top of the screen, displays

active programs and current time, enables you to switch to

programs and close screens.

J

S @ Use the command bar at the bottom of the
screen to perform tasks in programs.

e The command bar includes menu names,
buttons, and the Input Panel button. To create
a new item in the current program, tap New. To
see the name of a button, tap and hold the stylus
on the button. Drag the stylus off the button so
that the command is not carried out.

Pop-Up Menus

Use pop-up menus to quickly perform an action on an item.
For example, you can use a pop-up menu to delete or make
a copy of an item. To access a pop-up menu, tap and hold
the item that you want to perform the action on. When the
menu appears, tap the action you want to perform, or tap
anywhere outside the menu to close it without performing
an action.

[@

o Tap and hold to display the pop-up menu.
9 Lift the stylus and tap the action you want.

o Tap outside the menu to close it without
performing an action.

| ¥ —Taptoswitchtoa
program that you
recently used.

Tap to switch to a
program.

— Tap to see more

_1 programs.
Tap to change device
settings.
Tap to see a Help topic
for the current screen.

[t el o £

Tap to display the
input panel

Tap to select Tap to select
menu commands  button commands

"I.'Il-rl-—rhhu---lnl
W E T iroa —
e ]
o

el e g e
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Notifications

Your device reminds you in a variety of ways when you have
something to do or receive a SMS. For example, if you've
set up an appointment in Calendar, a task with a due date
in Tasks, or an alarm in Clock, you will be notified in any of
the following ways:

B A message box appears on the screen.

you are using.

B A sound, which you can specify, is played.
B Alight flashes on your device.
B The device vibrates.
J .
&  To choose reminder types and sounds for your
device, tap m — Settings — Personal — Sounds
& Notifications. The options you choose here apply et bkt
throughout the device. T .
T eamn] By by o gl =
= M warw ] =
#|le|
A
e s - 3
- u )
2.2 Entering Information 8%
3
You can enter information on your device in several ways, s o 2 a
depending on the type of device you have and the program L g 'g
c
=

B Synchronizing - Using ActiveSync, exchange infor-
mation between your PC and device.

B Typing - Using the input panel, enter typed text into
the device. You can do this by tapping keys on the soft
keyboard or by using the handwriting recognition soft-
ware.

B Writing - Using the stylus, write directly on the screen.

B  Drawing - Using the stylus, draw directly on the
screen.

B Recording - Create a stand-alone recording or embed
a recording into a document or note.

For more information on ActiveSync, see Chapter 4.
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Using the Input Panel

Use the input panel to enter information in any program on
your device. You can either type using the soft Keyboard
or write using Letter Recognizer, Block Recognizer, or
Transcriber. In either case, the characters appear as typed
text on the screen.

To show or hide the input panel, tap the Input Panel button

. To see your choices tap the arrow next to the Input
Panel button.

a. To type with the soft keyboard %

[2) o Tap the arrow next to the Input Panel button
and then Keyboard.

9 To type lowercase letters, tap the keys with the
stylus.

To type a single uppercase letter or symbol, tap
the Shift key. To tap multiple uppercase letters
or symbols, tap the CAP key.

key and drag up.

To add a space, tap and hold any key and then
drag the stylus to the right across at least two

o For uppercase, tap and hold the stylus on the
others.

To backspace one character, tap and hold any
key and then drag the stylus to the left across
at least two others.

0 To insert a carriage return, tap and hold the stylus
anywhere on the keyboard and drag down.

When you use the input panel, your device anticipates the
word you are typing or writing and displays it above the input
panel. When you tap the displayed word, it is automatically
inserted into your text at the insertion point. The more you use
your device, the more words it learns to anticipate.

If you want to use larger keys, tap the arrow next

U to the Input Panel button — then tap Options —
select Keyboard in Input method and — then
select Large Keys.

Tap to change
input panel
[ mmas=-. ____—options.
I s
:| Tap to select an

Vi — input panel.

B B bk [ wTaptoseethe

™ lists of input
Tap to open the selected panels.
input panel.

Tap here if this
is the right word.
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b. Using Letter Recognizer

With Letter Recognizer you can write letters using the stylus
just as you would on paper.

ri; o Tap the arrow next to the Input Panel button ey e
and then Letter Recognizer. vl
B e
e Write a letter in the box. [Ty
L =g

When you write a letter, it is converted to typed text that ap-
pears on the screen. For specific instructions on using Letter
Recognizer, with Letter Recognizer open, tap the question
mark # next to the writing area.

T - I¥ &
oy I‘:i. [ F3
3
T
g 2
c. Using Block Recognizer A5
~ Q
With Block Recognizer you can input character strokes using T v<
the stylus that are similar to those used on other devices. ? 0 2
=
r:) @ Tap the arrow next to the Input Panel button gl

and then Block Recognizer. el I -
o Write a letter in the box.

When you write a letter, it is converted to typed text that ap-
pears on the screen. For specific instructions on using Block
Recognizer, with Block Recognizer open, tap the question
mark # next to the writing area.

-::1

.P'I.'I |

]
;
i
;
B
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d. Switching to Transcriber

With Transcriber you can write anywhere on the screen using

the stylus just as you would on paper. Unlike Letter Recog-

nizer and Block Recognizer, you can write a sentence or

more of information. Then, pause and let Transcriber change

the written characters to typed characters.

[a} @ Tap the arrow next to the Input Panel button
and then Transcriber.

9 Write anywhere on the screen.

For specific instructions on using Transcriber, with Tran-
scriber open, tap the question mark in the lower right hand
corner of the screen.

. i g rmn
Ll o Bamgenr

i tamend_F

il

Q- TS T AR

mm d Dmmde EE

e. To punctuate in Transcriber :

(92
o> o Tap the keyboard button ﬁ on the toolbar.

9 Tap the desired punctuation.
@ Tap OK to hide the keyboard.

f. To learn about writing in Transcriber :

QJ

> O Tap button [ on the toolbar.

o In the screen that appears, select the letter you
want to learn about, and then tap on one of the
examples given above.

For specific instructions on using Transcriber, with Tran-

scriber open, tap the question mark ' # in the right handj

corner of the tool bar. Glick on a letter

eDwE s v

T B84 Dmds B

il

ST e e i ) e

for a demonstration

Eolw  § ayay s
58 il 3 30 Lk P g Ty
ATTI L TARAT R R T

Li=F_= 10 B b
= -y = |




Pocket PC Phone User Manual 29

g. To select typed text :

If you want to edit or format typed text, you must select it
first.

Q} Drag the stylus across the text you want to select.
You can cut, copy, and paste text by tapping and
holding the selected words and then tapping an
editing command on the pop up menu, or by tapping
the command on the Edit menu

. To change word suggestion options, such as the
u number of words suggested at one time,
Tap ﬁ — Setting — Personal tab — Input —
Word Completion tab

2
8o
o =
53
~ Q
<

o
n:
£

h. Editing text
Each input program provides curser keys to move through text m

and backspace so that you can correct spelling, grammar or [

insert additional information. Alternatively, you can use your .".?.'.'..':'-_".'u','.'- rr'r_':;----—'
stylus to make an insert. T
After you have made an insert, you can use any of the in- Fegyrf iy [ 2y
put methods described above to add additional text at the G T
insertion point. -l T A

[ [ —— ..[:.—I
P ——
[ —

g
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2.3 Writing on the Screen

In any program that accepts writing, such as the Notes
program, and in the Notes tab in Calendar, Contacts,
and Tasks, you can use your stylus to write directly on the
screen. Write the way you do on paper. You can edit and
format what you have written and convert the information to
text at a later time.

To write on the screen :

[2} Tap the pen button to switch to writing mode.
This action displays lines on the screen to help you

write. Tﬂ E.. hl
paY

!

Some programs that accept writing may not Eu’ﬂ-'ﬂ..‘fl
U have the pen button. See the documentation for
that program to find out how to switch to writing
mode.

T -
[

Tap the Pen button and

use your stylus like a pen.

To select writing :

pocket PC

If you want to edit or format writing, you must select it first.

o
= o Tap and hold the stylus next to the text you want m

to select until the insertion point appears. i

TURN

9 Without lifting, drag the stylus across the text
you want to select. h

If you accidentally write on the screen, tap Edit, then Undo
and try again. You can also select text by tapping the Pen
button to deselect it and then drag the stylus across the
screen.

)
5
[=]
>
[=)]
£
3
[=]
c
X

You can cut, copy, and paste written text in the same way e '{ =
you work with typed text: tap and hold the selected words Tap the Pen button again to select
and then tap an editing command on the pop up menu, or the writing you want

tap the command on the Edit menu.
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Converting writing to text
[E; @ Tap Tools and then Recognize. (= i @

9 If you want to convert only certain words, select
them before tapping Recognize on the Tools T'IJ E..”
menu (or tap and hold the selected words and
then tap Recognize on the pop up menu). If a

word is not recognized, it will be left as writing.

If the conversion is incorrect, you can select different words
from a list of alternates or return to the original writing.

[2) Tap and hold the incorrect word (tap one word at a
time). On the pop up menu, tap Alternates. A menu
with a list of alternate words appears. Tap the word m
you want to use, or tap the writing at the top of the !
menu to return to the original writing.

g
=
z.

To get good recognition : et h
[EP o Write neatly.

e Write on the lines and draw descanters below the
line. Write the cross of the “t” and apostrophes
below the top line so that they are not confused
with the word above. Write periods and commas

above the bottom line. m

o For better recognition, use the Tools menu to

2
8o
o =
x5
°a
o<
8%
c

increase the zoom to 300%. Tu E__H |
@ write the letters of a word closely and leave UL PORT
big gaps between words so that the device can gl
easily tell where words begin and end. —
g —
© Hyphenated words, foreign words that use .
special characters such as accents, and some
punctuation cannot be converted. -
If you edit or add to a word after attempting to recognize it, [ o o 1 L
the new writing will not be included if you attempt to recog- Tap the word you want to use
nized it agan. or, tap to return to your original

writing.
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2.4 Drawing on the Screen

You can draw on the screen in the same way that you write
on the screen. The difference between writing and drawing
on the screen is how you select items and how they can be
edited. For example, selected drawings can be re-sized,
while writing cannot.

To create a drawing : [ =0
- -
&  Cross three ruled lines on your first stroke. A drawing h
box appears. Subsequent strokes in or touching the |
drawing box become part of the drawing. Drawings ]
that do not cross three ruled lines will be treated as 1
writing.
The drawing box indicates a
the boundaries of the drawing.— [ "
=TT &
To select a drawing : ' Pen buton

If you want to edit or format a drawing, you must select it
first.

O
o
o)
9
=
[%]
=}
Q

[;) o Tap and hold the stylus on the drawing until the
selection handle appears. To select multiple
drawings, deselect the pen button and then
drag to select the drawings you want.

)
=3
o
>
o
=
3
e
o
X

9 You can cut, copy, and paste selected drawings
by tapping and holding the selected drawing and
then tapping an editing command on the pop
up menu, or by tapping the command on the
Edit menu. To re-size a drawing, make sure the
Pen button is not selected, and drag a selection
handle.

To change the zoom level so it is easier to work
U or view your drawing, tap Tools and then select
a zoom level.
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2.5 Recording a Message

In any program where you can write or draw on the screen,
you can also quickly capture thoughts, reminders, and phone
numbers by recording a message. In Calendar, Tasks, and
Contacts, you can include a recording in the Notes tab. In the
Notes program, you can either create a stand-alone recording
or include a recording in a written note. If you want to include
the recording in a note, open the note first. In the Inbox pro-
gram, you can add a recording to an e-mail message.

H Indicates an embedded
To create a recording il
d
= o Hold your device’s microphone near your mouth L
or other source of sound. a f
9 Tap "‘-r — Notes — =|
oie
o To start recording, tap |:| A beep will sound. Erom adam

o To stop recording, tap |?| Two beeps will sound.
The new recording appears in the note list or as

an embedded icon. -
wn| [mm]u =]
[ 84 Fake m-

You can also make a recording by pressing the T :
Record button - the first button from the top on Tap to show or hide

A n the Recording toolbar
the left side of your device.

2
8o
o =
x5
°a
o<
8%
c

Tap to begin recording
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2.6 Finding and Organizing
Information

The Find feature on your device helps you quickly locate
information.

r“ o On the -r — tap Find.

e In Find, enter the file name, word, or other
information you want to search for. If you have
looked for this item before, tap the Find arrow
and select the item from the list.

o To help narrow your search select a data type
under Type.

o Tap Go. The My Documents folder and sub-
folders are searched.

© In the Results list, tap the item you want to
open.

o
o
o)
9
=
[%]
=}
Q
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3
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# To quickly find information that is taking up storage
u space on your device, select Larger than 64 KB
in Type.
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3.1 About Your Phone

Like a standard mobile phone you can use your Pocket PC
to keep track of calls and send SMS messages. You can also
take notes while talking, dial directly from Microsoft Contacts
and easily transfer contacts between your SIM card and the
RAM of your device.

About SIM cards

The Subscriber Identification Module (SIM) card, also referred
to as a smart card, fits into your device. It can contain:

B Mobile phone service provider account details.
B Information regarding service access and preferences.

B Contact information, which can be moved to Contacts on
your device.

B Any additional services to which you may have a sub-
scription.

For more information regarding SIM cards, see your mobile
phone service provider’'s documentation.

To install a SIM cards :

d
2 o Turn over your device and press the fixing lock
button to remove the back cover.

REMOVING THE BATTERY WILL TURN OFF
YOUR DEVICE, MAKE SURE YOU HAVE SAVED
ANY DATA IN OPENED PROGRAMS.

“ BE SURE TO CHECK THE BACKUP BATTERY

POWER REMAINS AT LEAST AT 50% OR
ABOVE BEFORE YOU REMOVE THE MAIN
BATTERY BY TAPPING E — Settings —
System tab — Power.

By ‘o—'-ﬂ-.l

Sl oo iR L oS ol T
g Ly e b e s
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9 To unlock and remove the battery, press the
stylus into the slot under the bottom end of the

battery.

Press to
unlock and
remove the
battery.

9 Lift up the SIM card case and insert the SIM.
Push the SIM holder down, then push towards
the middle until it clicks. %

&
332
ou
=
)
c
=

o Replace the battery and back cover. Remember
to push back the red lock point to clip it into place
at the bottom.Push it forward and pull back to
secure the SIM.

Press to lock
and fix the

\:attery.

“ IF YOU REMOVE THE MAIN BATTERY, THE

BACKUP BATTERY CAN ONLY KEEP YOUR
DATASAFE FOR 20 MINUTES WHEN IT IS 100%
CHARGED, BE SURE TO REPLACE THE MAIN
BATTERY BACK INTO PLACE RIGHT AFTER
THE SIM CARD IS INSERTED.
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About The Dialer Screen

To access the Dialer Screen, tap m then Phone, or press
on your device. From this screen, you can access Call

Log, Speed Dial and Phone Setting. Signal status information

and important icons that tell you about your call include :

rﬁ} o The icon indicates the strength of the signal.
o Last number details are displayed here.

Keypad for inputting.

Task bar to access phone setting.

View all history including all received, dialed and
missed calls.

Stores numbers you call often.

Q0 000

Tap to make a call.

1
3 0
> £
g
)

-

Indicators

Below are some of the status icons you may see. \—{
o

Indicator Meaning

7 Phone off or out of network service. Tap this
® icon to turn on the phone

et | B[

00 -0

the phone.

- In network service, tap this icon to turn off
AN

1 Call Missed. Tap this icon to view the call(s)
you missed.

Unread E-mail or SMS. Tap the icon to view
unread SMS or E-mail.

=
tai Connecting in progress. The icon will dis-
- appear when you are connected to your
ISP.

?" Indicates your connection is at full
strength.
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The Navigation Pad and Dialing

[pa)

o> @ Take Call - Press to take an incoming call. (1) (2] (3]
Dialer Screen -Press to activate the dialer
screen.

Speakerphone - During a call, press and hold
to turn the speakerphone on or off.

Dial - Press to dial a number.
Scroll Up - Press to scroll up through a list.
End Call - Press to end a call.

Call Log - After launching the dialer screen,
press to enter the Call Log feature.

Scroll Down - Press to scroll down through a
list.

Center - Press to select a menu item.

0® O® 000

Speed Dial - After launching the dialer screen,
press to enter the Speed Dial feature.

&
332
ou
=
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Entering Your PIN

Most SIM cards are preset with a PIN ( Personal Identifi-

cation Number), provided by your mobile service provider,

which you need to enter whenever you use your device. o i e

[EP o Enter the preset PIN assigned to you by your
mobile phone service provider (please contact
your mobile service provider).

e Tap Rk button.

If your PIN is entered incorrectly three times, the

” SIM card will be blocked. If this happens, you can
unblock it with the PIN Unblocking Key from your
mobile phone service provider.
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Checking Your Connection

The default settings for your device are programmed to as-
sume that you want to use your phone. Provided you have
inserted a SIM card, your device will automatically connect
your mobile phone to your service provider’s network.

The icon Y indicates that you are connected to your service
provider's network. A full strength signal is indicated by Tl
As the strength of the signal diminishes so will the number of
vertical bars in the icon, with no bars indicating no signal.

IN MANY COUNTRIES YOU ARE REQUIRED BY
LAW TO TURN OFF YOUR PHONE WHEN YOU
FLY. TURNING OFF YOUR POCKET PC DOESN'T
TURN OFF YOUR PHONE; YOU MUST TURN
OFF YOUR WIRELESS CONNECTIONTO YOUR
OPERATOR’S NETWORK.

Turning The Phone On and Off

You can turn your phone on and off while keeping your actual
device turned on.

[2} o While using any program on your device, tap Y
in the title bar at the top of the phone’s display.

9 Tap Turn on or Turn off option in the pop-up
menu.

o To receive calls when your device is turned off,
leave the Phone turned on.

u You can use other programs on your device during
a call. To quickly switch back to Phone, tap "_'.|, or
tap — Phone.
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Adjusting The Phone Volume

C‘ @ During a call, tap 4% or press the volume on
the side of your device.

9 You can select to adjust the phone volume 'T‘"

(ring) or device volume ﬂé (notification levels
and MP3) on the pop-up menu.

© f you select Vibrate mode, 4t will appear in
the title bar at the top of the phone display.

auoyd
JnoA buisn

@ Turn off the volume by choosing the Off
option.

f To adjust the conversation phone volume, you

“ must do it during a call. Adjusting the volume at
another time will affect the ring, notification and
MP3 levels.




42 Pocket PC Phone User Manual

3.2 Making a Call

With your Pocket PC Phone, you can make a call from
the Dialer, Contacts, Speed Dial, Call History, and SIM
Manager.

To make a call from the Dialer :
The most direct method is by using the Phone keypad.
Q2

o> o Press '. to bring up the dialer screen.

@ Tap the number on the keypad then tap S5
or press button.

1
3 0
> £
g
)

-

Back Spacing and Deleting

d
& If you tap a wrong number, you can back space to
erase individual numbers one at a time.

[—‘& You can also delete all the numbers in the window by
tapping Edit and then Clear.

E';h} TrO-641
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To make a call from Contacts :
You can make a call from Contacts in the following ways :

Option 1

R g e s L]
Byt [ olel o

J

= Press the Microsoft Contacts Button, find the contact
and then tap '. twice -- once to send to the dialer
screen and once to call.

u The pop up menu and '. button will by default

display Call Work Tel. However, you can

customize it so that the mobile number or e-mail

is displayed instead, see Option 3 below for
specific details.

&
5
° (ﬂ
3
33
<
Option 2
Q} Select a contact in the contacts list and then press
left or right on the navigation pad -- the number on
the screen will change.
tap the w here to pop-up all the phoned
Option 3 numbers and e-mail for this contact
(3} ) . .
G} o In the contacts list, tap the w in the right column

next to the contact you want to customize. A
pop-up menu will display the phone numbers
and e-mail addresses for this contact with a dot
next to the priority number.

e In the pop-up menu select a priority -- If you
selected mobile number, m should now be in
the right column next to the contact.

e B -]
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To make a call from Speed Dial :

Create speed dials to call frequently-used numbers with a
single tap. Before you can create a speed dial entry for a
phone number, that number must already exist in Contacts.

J
o> o From the Phone keypad, tap m —

New.
o Tap the desired contact name and number.

o In the Location field, tap the Up/Down arrows to
select an available location to assign as the new
speed dial entry. The first speed dial location is
reserved for your voice mail.

By memorizing the position in the Speed Dial list of a number,
you can dial the number by entering its position number.

For example:

In the picture on the up-right, Alex Liang is at position 3. To
dial his number simply tap and hold 3 on the dialer keypad; if
the number holds a position of 10 or more, tap the first number,
and then tap and hold the second to dial.

L

By default the Location function will give you the
next available position in the Speed Dial list. If you
want to put a number in a position that is already
occupied, the new number will replace the number
already there.

Tips for Speed Dial setting

rﬁ} To create a speed dial entry from Contacts, tap and
hold the contact name, tap Add to Speed Dial, and
then tap the Up/Down arrows to select an available
location to assign as the new speed dial entry.

rﬁ) To delete a speed dial entry, go to the Speed Dial

list, tap and hold the contact name in the box to the
right of the assigned speed dial number, and then
tap Delete.

Lpamr

irSe™ L opwd T
s [l
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To make a call from the Call
History :

[a>

(2]

o Go to Phone and press the right side of the

oF Pty

navigation pad or tap

Find the call details by first selecting the category
it is filed under. For example, if it is in All calls
select All calls from the drop down menu in the
top-left corner.

Use the navigation pad to find the number and

then tap '. or the icon to the left of the number
you wish to call.

Call History icons include :
— incoming calls ; — outgoing calls;

— missed calls.

To make a call from SIM Manager :

[T»

0 Tapm

— Programs — SIM Manager -- wait
for your SIM card contents to load.

9 Tap and hold the name or phone number of the

person you wish to call, and then select Call
from the pop-up menu.

(LR PR
VOl
S -

A
n [ | B
m (o | g s
n (B | B3] % lma.
' [T PR
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3.3 Receiving a Call

To answer an incoming call :

Jd
o> o Tap Answer, or press '. on your device.
9 Tap Ignore or press '-' to reject the call.

u If you reject a call the busy tone will be sent out.

Toend a call :

Cﬂ]} Once an incoming or outioincl; call is proceeding, you
can press '-' or tap to end the call.

In-Call Options

Your device notifies you when you have another incoming
call and gives you the choice of rejecting or accepting the
call. If you accept, you can choose to switch between the two
callers or set up a conference call between all three parties.
A conference call can include up to six people. See page 47
for more details.

Putting a call on hold

(72
o> o Tap Answer to the take the 2" call and put the
1t on hold.

9 To end the 2™ call and go back to the 1%, tap
or press @ .

|n s LIE 1R

[ s LI 1H®
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To swap between calls :

[& You can choose to swap backwards and forwards
between 2 callers by pressing

To set up conference calls :

[ab o Either put a call on hold, dial a 2 number and
wait for it to be picked up. Or, accept a 2nd
incoming call when you already have one in
progress.

In the screen that appears tap H .

o If the conference connection is successful the
word Conference will appear at the top of the
phone dialer screen (see right).

auoyd
JnoA buisn

o To add additional people to your conference

call tai m key in the number, and then
to return and continue.

Making a Note

Regardless of whether you call from the Dialer, Contacts,
Call Log, Speed Dial or SIM Manager, you can take notes
during a call. After you have finished the note it will be saved
as an attachment to your call in one of the Call Log folders.

a. To make a note : i — 3
e

ﬂ Prim L Peme 11700 s

o> o After you have entered a number and tapped 1

'- or m tap the r: icon at the bottom L

of the screen.

9 Use any of the input methods to record your note
and then tap OK. You can finish your note during
or after the call.

T N |
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Making a Note (Cont’'d.)

b. To view a note :

i
o> o Press the right side of the navigation pad or tap
, tap and hold the call, and then from
the pop up menu tap view note. (The icon
indicates a note).

o Or, go to Notes, and then tap the name of the file
from the list. (For more information, see Chapter
2 Entering information.)

. If you decide to create a contact for this caller -- see

u Adding and Transferring Contacts information

in section 3.5 later in this chapter -- the call and

file names will be amended to the name of the new
contact; the file will be unaffected.

Enabling the Speakerphone Mode

Your device has a speakerphone allowing you to talk hands-
free and/or let other people listen to the caller.

i
S o Wait until the phone is ringing.

e Hold down L until the speakerphone comes
on and the icon 1'-" appears in the top toolbar.

o To turn off the speakerphone hold down L
again.

DO NOT LEAVE THE PHONE IN SPEAKER-
PHONE MODE AND HOLD IT ON YOUR EAR;
THE SOUND WILL DAMAGE YOUR EAR.

tap here to view the notes

L b —
m [T .
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3.5

Checking Your Voice Mail

The first speed dial location defaults as your voice mailbox.
When you insert your SIM card into your Pocket PC Phone, it
will automatically detect and set as default the voice mailbox
number of your mobile service provider.

To retrieve your voice mail :

ré} On the Phone screen, tap m or press the left
side of the navigation pad, select Voice Mail
and then press @ .

Contacts Information

Contacts can be imported in the following different ways:

F‘ o Your SIM card - You interchange your SIM card
between your Pocket PC Phone and another
device; while using the other device you create
one or more new contacts on the SIM card.

9 Call History - New contact numbers can be
found in incoming or missed calls.

u Important to import contacts -
1 Backup your SIM numbers to your device.

2 Speed Dial numbers must be setin Contacts,
not on the SIM card.

3 Creating Contacts in Microsoft Contacts
creates more detailed records.

&
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SIM Manager

To open SIM manager, tap ﬁ — Programs — SIM Manager
-- wait for your SIM card contents to load.

a. To create a SIM contact :

2
o> o After the SIM contents have loaded, tap New.

e Fill in the Name and Phone details then tap

Add. ATl aTnTale[RTaTa <]

L
G

i:.i;i'.'n': 'E

b. To transfer contacts from SIM to
Contacts :

Q
c
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Option 1

1

3
>
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rﬂ]} On SIM Manager display, tap Tools — Select All —
and then Save to Contacts.

Option 2

‘D

Press and hold the center of the navigation pad - or
tap and hold a contact from the list - and then select
Save to Contacts from the pop up menu.
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c. To save personal numbers :

You can choose to save your personal phone numbers in a
separate screen in SIM Manager.

[_,“

o Tapm — Programs — SIM Manager — Tools
— and then List of Own Numbers.

9 Add a number to the screen and then tap OK.

Call History

Tap m on the phone screen to pop-up the call history
list to the right :

To add a record to Contacts from Call
History :

(3}

‘P o Find the call details you want to add.

e Press and hold the stylus or press and hold the
navigation pad center; select Save to Contacts
in the pop-up menu that appears .

e In the Save to Contacts screen, add additional
contact details and press the navigation pad
center or tap OK.

The call details in the Call History will then be amended
and displayed under the name of the contact, not their tele-
phone number.
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Manage Your Call History

Call History details all incoming, outgoing, and missed calls
and also provides a summary of total calls. Call History can
also tell you when a call was initiated, how long it lasted, and
provides easy access to any notes taken during the call.

a. Viewing calls details

Tap in the top left corner of the screen and then select a
category from the drop down menu.

Calls are categorized as follows:

m All Calls - displays all calls made to and from the
phone in chronological order.

H Missed m - displays calls that were not
answered.

1
3 0
> £
g
)

-

B Outgoing m - displays calls made from the
phone.

B Incoming m - displays calls made to the
phone.

By Caller - list calls alphabetically
according to caller.

b. To view duration of calls :

‘B

Go to Call History, find the call you are looking in,
and then tap it once.

c. To delete Individual calls from Call
History :

i
= Tap and hold the stylus on the call to be deleted, and
then select delete from the pop up menu.

FEFETON T
R
ur—an.nn
]

d. To delete all calls from Call History :
[a} Tap Tools — and then Delete all Calls.
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3.6

e. To set limits on the size of your Call
History :

J
> O Tap BB . ol Timers and then the box

under Delete call history items older than.

In the drop down menu select a time period then
tap OK.

o Photo Contacts

Photo Contacts makes using your Pocket PC more fun
and practical than ever before. It allows you to assign still
or animated photos to the entries in your Contacts. Then
when a person calls you (for whom you have previously as-
signed a photo ID in Contacts), that photo ID will appear
on your Pocket PC’s incoming call screen. Use the rich set
of features to get the photos displayed with the size, position,
and animated ID template you want.

To create a new photo contact:

Q2 @

= 0 Tap ﬁ — Programs — Photo Contactsii.

9 Select a contact from the list, or create a new
one by tapping Edit — then New.

Contacts here fully mirror those in Microsoft
Contacts.

o Tap Edit — then Assign Photo...

o Tap next to Type to select the type of files you
want listed, ie, jpeg, bmp, gif or all — Tap next
to Find in: to select the location of a file.

You can use JPEG, BMP, still GIF, or animated
GIF files for your Photo IDs.

L

e Tap a picture file, then OK, and OK again until
you return to the Contacts screen. You can see
the photo at the bottom of the screen.
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To preview and adjust settings:

In step 5 above, after you tap OK once you will arrive at the
preview and display settings screen.

In Display Settings you can:

2 _—

(=S o Add extra style by assigning a template to the
photo.

A few sample Photo Contacts templates
U (animated graphical templates that can frame your
assigned photos) are included in your Pocket PC’s
local storage in the \My Documents\Templates
folder. For more templates go to IA Style website
http://www.iastyle.com

9 Choose how you want the photo to fit to the
window.

o Enlarge the photo if it is smaller than the
window.

o Choose a size and position for the picture.

e Preview all of these changes by tapping
Preview.

Toolbar Icons

The Toolbar provides a convenient way for you to select fre-
quently-used commands. Each is explained in more detail
in its own subsection later in this Manual. From left to right,
the functions of the icons on the Toolbar are:

@ B Create a new Contact entry (same as
New... on the Edit Menu).

Modify data for the selected Contact entry
(same as Edit... on the Edit Menu).

EE' u

% B Delete the selected Contact entry (same
as Delete on the Edit Menu).
@ ||
+

Assign a Photo ID to a Contact entry
(same as Assign Photo... on the Edit
Menu).

299 o

l.[A

. Sie Al %

Elnllru-n-ﬂlml O
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Preview with a selected
template.
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@ B Remove a Photo ID assignment (same as
* Unassign Photo on the Edit Menu).

rf_w B Preview the current Photo/template as-
= signment (same as Preview... on the View
Menu).

_ B Invokes “Detailed View” for the current
entry (same as Properties... on the View
Menu).

B Opens the Options screen (same as Op-
tions... on the Tools Menu).

To assign a photo from the camera:
Q2
o> 0 Tap m — Programs — Photo Contacts.
e Select a contact from the list, or create a new

one by tapping Edit, then New. Contacts here
fully mirror those in Microsoft Contacts.

&
332
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o Tap Edit then Assign Photo From Camera.

o After you take the picture, you will be returned
to the Display Settings and Preview screen.

To unassign a photo:
Q
S 0 Tap m — Programs — Photo Contacts..

9 Select an existing contact entry that you want to
remove.

© Tap Edit — then Unassign Photo — Tap yes in
the pop-up box.

To view your contacts by photo:

2
L 2 o Tap m — Programs — Photo Contacts.

Tap -- on the Command Bar; Or, tap View —
then Photo Dialer View.
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When in Photo Dialer view mode, the View Menu contains
three additional commands that allow you to specify the
size of the thumbnail images: Large Thumbnails, Normal
Thumbnails and Small Thumbnails.)

You can enter the Detailed View of Photo Contact using
any of these methods:

B Select the desired Contact entry — then select Proper-
ties... on the View Menu.

B Select the desired Contact entry — then tap the Proper-
ties icon on the Toolbar.

B Select the desired Contact entry — then press the Action
button on your Pocket PC.

B Double-tap a Contact entry.
To disable the displaying of photos:
S

o Tap m — Programs — Photo Contacts..

@ Tap Tools — Options — then uncheck the
Display photo during incoming or waiting
call box.

To manage your groups:

You can create a new group, rename, delete, and assign and
unassign a photo to a group.

[a) Tap Tools — then Manage group.
To assign a contact to a group:
["]> Tap m — Programs — Photo Contacts..

Select a contact from the list, or create a new
one by tapping Edit, then New. Contacts here
fully mirror those in Microsoft Contacts.

Tap Edit — then Assign Group.
Select a group from the list, then tap OK.

00 00

To unassign tap Unassign Group on the Edit
menu.
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Show Contact Names Only

When Show Contact Names Only is selected on the View
menu, only the name of each Contact entry (no phone num-
ber or other data) will be listed. The Photo ID (if any) will I

still be displayed.

Set Default Photos... i) B e

The Set Default Photos screen lets you assign, unassign,

and preview default Photo IDs to appear for these three [t

situations: -

ol Pt

-
B =
- -

Unknown photo

This photo will display whenever the phone number of the incoming call is
not known to Caller ID because no phone number was “passed in” to your
Pocket PC. This would occur if the person calling you has blocked their
phone number from being displayed to the receiver, or has not enabled
the broadcast of their Caller ID.

Not-found photo

This option in the Set Default Photos screen lets you assign a generic
Photo ID to any incoming call from a person whose number is not found in
your Contacts. Thatis, the phone number of the incoming call is known,
but has no matching entry in your Contacts.

Default photo

This photo will display when the incoming call is found to be from a
matching entry in your Contacts database, but so far there is no individu-
ally-assigned Photo ID for either that individual Contact entry, or for the
Group it belongs to.

[‘

© © ©

To select Set Default Photos...tap Tools — then
select Set Default Photos.

Check a circle next to one of the categories, then
tap Assign.

Select a picture, then assign settings.
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3.7 Additional Dialing
Information

To make an emergency call :

2 . .
& Enter the international emergency number 112 then
or press '. button.

B Some mobile phone service providers may
U require that a SIM card is inserted and/or a
PIN entered in order to 112. Consult with your

service provider for more information.

B Additional emergency numbers may be
included on your SIM card. Consult with your
mobile service provider for more information.

1
3 0
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g
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To make an international call :

(3}
o> o Tap and hold the “ key until the+ sign
appears. The + replaces the international prefix

of the country of where you are calling. i bl
&1 [¥34) S67=80
e Enter the full phone number you want to dial. It
includes country code, area code (without the

leading zero) and phone number.

9 Tap or press '.

3.8 Secure Your Phone

You can customize the level of security you want to have on
your Pocket PC phone by locking the keypad, the entire device,
or the SIM card.
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Locking the keypad

The keypad lock turns off the keypad functionality. This is a
helpful feature if, for example, your Pocket PC phone is turned
off and in your pocket, and you want to prevent accidental
keypress from pressing a button etc .

J

> o Tapping E — Settings — System tab —
Button Lock

9 Select Lock all buttons except Power
button.

9 To unlock your keypad, tap Do not lock
buttons.

Locking your phone

Locking your Pocket PC phone prevents access to personal

data. When you enable this feature, your Pocket PC phone

will automatically lock after a specified time of inactivity. A

screen will be displayed requiring your Pocket PC phone lock

password before access is granted.

E» 0 Tap E — Settings — Personal —
Password.

e Select the type of password you would like
to use : Simple 4 digit password or Strong
alphanumeric password.

Astrong password must have at least 7 characters
that are a combination of uppercase and lowercase
letters, numerals, and punctuation.

L

o Enter the password and, if necessary, confirm
the password.

o Select how long your mobile device must be
turned off before the password is required for
using the device by tapping Prompt if device
unused for.
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Locking the SIM card

You can protect your Pocket PC phone from unauthorized
use by assigning a PIN (Personal Identification Number).
Your first PIN will be given to you by your mobile phone
service provider.

J
o> o From the Phone keypad, tap Tools — Options
— Phone tab.

9 Select Require PIN when phone is used.

9 To change the PIN at any time, tap Change
PIN.

! Emergency calls can be placed at any time,
u without requiring a PIN.
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Chapter 4

Synchronizing Information

“4.1-Using-ActiveSync——

—-4.3-Synchronizing:by:Using——
an-Infrared-Connection——

44 ActiveSyncErrors———
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4.1 Using ActiveSync

Using Microsoft ® ActiveSync® you can synchronize the
information on your PC with the information on your Pocket
PC Phone. Synchronization compares the data on your device
with your PC and updates both with the most recent informa-
tion. With ActiveSync, you can:

m Keep Pocket Outlook data up-to-date by synchronizing
your device with Microsoft Outlook data on your PC.

B Choose to synchronize Inbox, Calendar, and Contacts
with a server so that you have the latest information, even
when your desktop computer is turned off.

B Copy (rather than synchronize) files between your device
and your desktop PC.

B Control when synchronization occurs by selecting a syn-
chronization mode.

B Select which information types are synchronized and
control how much data is synchronized.

By default, ActiveSync does not automatically

u synchronize all types of information. Use
ActiveSync options to turn synchronization on
and off for specific information types.

Using Server ActiveSync, you can synchronize

U information directly with a Microsoft Exchange
Server if your company is running Microsoft®
Mobile Information Server 2002 or later.

Installing ActiveSync

Before you begin synchronization, install ActiveSync on
your desktop computer from the Pocket PC Phone 2003
Companion CD. ActiveSync is already installed on your
Pocket PC Phone.
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Creating a Partnership

After the installation is complete, the New T
Partnership Wizard helps you set up a part- | ===r==——== [ & |

nership between your phone and your desktop = ST
computer and/or a server so that you can start e :::.::..:..—-H
synchronizing information and customizing your

synchronization settings. : PR
O ——
In the New Partnership Wizard select St = =
U Synchronize with this desk-top

computer. Unless you are certain
that your company is running Microsoft
Mobile Information Server 2002 or later
and you know the server name, then
choose Synchronize with Microsoft
Mobile Information Server and/or
this desktop compute. For more
information, contact your network
administrator or service provider.

Select the items you want in the synchronization setting
then you can start to synchronize your data between
your device and your PC.

View connection status.

Your first synchronization will automatically begin
when you finish using the wizard. After the first (D | 7ap to connect anc
synchronization, you will notice that your Out- synchronize

look information now appears on your pocket - Taptostop
PC phone r I T synchronization

Byl pdl e . -
LMY L Tk — View synchronization
status. [ ‘<n
23
°s
5 5
(=]
Lo — Q3
.- g‘- N
L Tap to synchronized via IR or change =3 tg

synchronization settings.
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4.2 Synchronizing information

This section provides an overview of the types of Outlook [ 5|
information you can synchronize. By default, ActiveSync ¥
does not automatically synchronize all types of Outlook in- ; I a———

formation. Use ActiveSync options to turn synchronization
on and off for specific information types.

ey e [ —

Synchronizing Inbox

L R

When you select Inbox for synchronization in ActiveSync, —————
e-mail messages are synchronized as part of the general o SRR M o e
synchronization process. During synchronization, the fol- el

lowing events occur :

B Messages are copied from the Outlook Inbox folder on
your desktop computer, or from a Microsoft Exchange
Server, to the Inbox folder on your Pocket PC Phone.

B By default, when synchronizing Inbox information with
your desktop computer, you will receive only messages
from the last three days and the first 500 bytes of each
new message. You can also choose to download file at-
tachments.

B The messages on your phone and on your desktop com-
puter are linked. When you delete a message on your
phone, it is deleted from your desktop computer the next
time you synchronize, and vice versa.

B Messages in subfolders in other e-mail folders in Outlook
are synchronized only if the folders have been selected
for synchronization in the Inbox on your Pocket PC
Phone.

u SMS messages are not received in your Inbox
through synchronization. Instead, they are sent
to your phone by way of your service provider.
For more details, please see Message Features

in Chapter 8.
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Synchronizing Calendar
B Calendar items stored on your Pocket PC [EilSiscsn e

Phone can be synchronized with calendar | &= &= 2= &

items stored on your desktop PC and/oron | # = = 4 &

a Microsoft Exchange Server. By default, L

calendar items from the last two weeks will | @'

be synchronized. SR

B Calendar items created on your Pocket
PC Phone are copied to your desktop PC

slamssa Tus .

e SR P P

and/or server during synchronization, and | L= -
vice versa. Similarly, Calendar items thatare | = Y b
deleted from your phone are deleted from ':l. = T

your desktop computer and/or server during
synchronization, and vice versa. This keeps your informa-
tion up-to-date in all locations.

Synchronizing Contacts

B Contacts stored on your phone can be synchronized with
contacts stored on your desktop computer or on a Micro-
soft Exchange Server. By default, all of your contacts will
be synchronized.

B Contacts created on your phone are copied to your desk-
top computer and/or server during synchronization, and
vice versa. Similarly, contacts that are deleted from your
phone are deleted from your desktop computer and/or
server during synchronization, and vice versa. This keeps
your information up-to-date in all locations.

Synchronizing Tasks

B Tasks stored on your phone can be synchronized with
tasks stored on your desktop computer. Task synchroniz-
ation is automatically selected in ActiveSync. By default,
all of your incomplete tasks will be synchronized.

B Tasks created on your phone are copied to your desktop
computer during synchronization, and vice versa. Simi-
larly, tasks that are deleted from your phone are deleted
from your desktop computer during synchronization, and
vice versa. This keeps your information up-to-date in all
locations.

]
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2 Tasks can be synchronized only with your desktop
u computer. They cannot be synchronized with a
server.
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4.3 Synchronizing Using an
Infrared Connection

You can use an infrared connection to create a direct con-
nection between your phone and another mobile device or
desktop computer quickly. This method is ideal for quickly
switching between multiple devices since there are no
cables or adapters to change. When creating a partner-
ship, you must connect using infrared, a cable, or a cradle
connection.

For more information about synchronizing using an infrared
connection or other connection types, see ActiveSync Help
on your desktop computer.

Transferring Items Using Infrared

Using infrared (IR), you can also send and receive information,
such as contacts and appointments, between two devices.

a. To send information :

i

o o Switch to the program where you created the
item you want to send and locate the item in the
list.

e Align the IR ports so that they are unobstructed
and within close range.

o Tap and hold the item, and tap Beam Item on
the pop up menu.

u You can send items, but not folders, from File
Explorer. Tap and hold the item you want to send,
and then tap Beam File on the pop up menu.

b. To receive information :

ré} o Align the IR ports so that they are unobstructed
and within close range.

e Have the owner of the other device send the
information to you. Your device will automatically
receive it.
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4.4 ActiveSync Errors

Whenever ActiveSync cannot successfully synchronize your
information, it displays an error on your phone.

To view ActiveSync error
information

[—“ Press the Action button when the error text is
displayed. ActiveSync will then display more
information about the error that occurred.

Some types of errors can interfere with automatic

U synchronization. If you suspect that a scheduled
automatic synchronization has not occurred, you
should attempt to manually synchronize your
information. Successfully completing manual
synchronization will reset automatic synchronization.
For more information, see the Synchronizing
Information section of ActiveSync Help on
your desktop computer.
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Chapter 5

Personalizing Your
Pocket PC Phone

~5.1-Device Settings——
—————5.2-Phone-Settings——
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5.1 Device Settings

You can adjust device settings to suit the way you work. To
see available options, tap — Settings — Personal or
System tab located at the bottom of the screen.

o
£
=
©
c
o
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o
o
o

Personal Tab

l Button
Assigns an application program to hard
ware button.

ﬁ Input

Sets up the input portion of your device.

m Menus
- Customizes the menu appearance and enables
a pop up menu from the New button.

E_:l Owner Information
Displays your contact information.

-g!!q_ Password

Limits access to your device.

I‘I& Phone
Sets up the phone function of your wireless
feature.

-;E Sounds and notifications
! Sets the notification type, event and volume.

% Today
Customizes the look and the information that
appears on the Today screen.

System Tab

n About
Displays important device information.

'HE Add ring tone
= To listen to and select new ring tones.
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v
(0]
-
(]
 E
- } 1 9
& Backllg.ht ' ' .k g - Al =
] Customizes the backlight and brightness for e i 5
power saving purpose. E.. ﬁ' = U Q
vt Saifen ek el afen
Button Lock I:;H-
g Enables you to lock the buttons on your device ﬂ ™ |
except Power button when device is off. Pk Wi -y
G Certificates 2 o W |
- Displays the name of the certificate issuer and peeeers B ey
the expiration date. -
@ Clock
Changes the time and sets alarms >
Device information [ R
Find information about version, hardware, S
identity and call duration. "3 & ‘ 1
[+ 9% aram ——mary
Memory b el ;
% Displays the memory allocation status and cur- ﬂl ﬁ iy i
rent running programs. e — g e
(?, Microphone AGC ‘ g ﬂ“
L Adjusts the volume automatically when you — —reder—— o]
are recording e e |
-I.

Permanent save
Saves contacts to permanent flash memory.

Power
Maximizes battery life.

Regional settings
Customizes the region and relative format for
the region you use.

Remove programs
Creates more memory by removing pro-
grams.

Screen
Re-calibrates the screen and enable/disable
Clear Type feature.

BN esR
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2 ﬂ.Buttons
‘N
'T_, To change the assignments for your device's four program m
= buttons : e
(7] e sl g b e
b o [
P e o> o Tap ﬁ — Settings — Personal — Buttons. mee I_Irqr'-.n
;: =Tl
o AT
L R =
R
] v
e Select a button, a program in Button [
Assignment, and then tap OK. e s . [ T,
--.

o In the Up/Down Control tab Delay before first
repeat changes the time elapsed before scrolling
begins. Repeat rate changes the time it takes
to scroll from one item to the next.

E=1 Input

(3
o> o Tap E—» Settings — Personal tab — Input.

9 Select an input method and change desired m

options on the Input Method tab; Select
desired option for word completion on the
Word Completion tab, and options for writing

and recording on the Options tab. These options S e P e
apply to any program on the device where you iy

can record or write.

¥ gl i v I—h—dll':i-nlr
1 Vi S e B L e T

U You can also change input Options by tapping el ey
the = arrow and then options. =
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E':l Menus

To add the programs you use most often to Start E .

[E>

wy

@ Tap B settings — Personal tab —
Menus.

9 Select the programs you want, then tap OK.

e On the New Menu tab, you can select Turn on
New button menu and then select the items
to appear on the menu. When you do this, an
arrow appears next to New in the command
bar of certain programs such as Pocket Word,
Pocket Excel, Contacts, Calendar and Tasks.
You can tap this arrow and then tap a new item
to create.

You can create subfolders and shortcuts to appear
under . InActiveSync on your desktop PC, click
Explore — Double-click My Pocket PC — click
Windows — click Start Menu — then create the
folders and shortcuts that you want.
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E—l Owner Information

J
o> o Tap ﬁ — Settings — Personal tab — Owner
Information.

9 On the Identification tab, enter your personal
information. Select Show information when
device is turned on so that if you lose your
device, it can be returned to you.

o On the Notes tab, enter any additional text you
want to display when the device is turned on,
such as: Reward if found.

™4 Password

J
o> 0 Tap E—> Settings — Personal —
Password.

9 To select how long your mobile device must be
turned off before a password must be entered,
check Prompt if device unused for.

o Select the type of password you would like
to use. A strong password must have at
least 7 characters that are a combination of
uppercase and lowercase letters, numerals, and
punctuation.

o Enter the password and, if necessary, confirm
the password.

U B [f your device is configured to connect to a
network, use a strong password to help protect
network security.
B [fyou forget your password, you must clear the
memory before you can access your device.
This will erase all files and data you have
created and programs you have installed.
For more information about clearing memory,
please see Appendix A.
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® Sounds and Notifications

% 0

(2]

Tap E — Settings — Personal tab — Sounds
& Notifications.

On the Volume tab, you can select the actions
for which you want to hear sounds. If you don’t
want to hear sounds, move the System volume
slider to Silent.

On the Notifications tab, you can customize
how you are notified about different events.
Select the event name and then select the type
of reminder. You can select a special sound, a
message, or a flashing light.

Turning off sounds and the notification light
helps conserve battery power.

Use Phone settings to change the ring type
and volume for your phone. For more details
see the Phone Setting section in Chapter
3.

Q} Today

You can customize the Today screen the following ways:

a. To change the background :

o
2]

Tap [ — Settings — Personal tab —
Today.

On the Appearance tab, select the desired
theme for the background. To use your own
background, select Use this picture as the
background then tap Browse to locate the
desired file.

Choose a folder and tap the file you want then
tap OK.
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b. To customize the information you want T
displayed :

(pa)
o> o Tap E — Settings — Personal tab — Today
— then Items tab.

o
£
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o Uncheck a box to remove its information.

o To change an item's position select it then tap
Move Up or Move Down.

o To choose how long the Today screen is
displayed, select/deselect Display Today
screen if device is not used for, then the
number of hours.

c. To customize Tasks or Calendar :

(pa]
& Select Tasks or Calendar, and then Options to
further customize.

“ B You can find additional pictures on the

Pictures & companion program. See detailed
information in Chapter 9.

® Recommend picture size is 240x320 pixels in - L
Jpg file.

& Backlight

“ Using the backlight while on battery power

substantially reduces battery life. m

¢ ——
= o Tap ﬁ — Settings — System tab — T
Backllght e g bt mrd erar i B
inna a1  a
o Tap Battery power tab to turn on/off the back- ittt - O

light when using battery power.

— g o g i g Rt
L ]

Tap External power tab to turn on/off the back-
light when using external power.

© 0

L
Tap Brightness tab to adjust the brightness ::._,T.F..,.; .—:.:.
level. N ©
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@ Clock

[‘

Tap — Settings — System tab — Clock.

If you visit a particular time zone often, select it as your
Visiting time zone on the Time tab so that you can quickly
see the correct date and time.

You can use your device as a travel alarm clock by setting
a wake-up alarm on the ACs tab. Tap the alarm icon to
select the type of alarm you want.

To change the appearance of the date and time, go to
Regional by tapping — Settings — System tab —
Regional Settings.

T Memory

f;}

Tap — Settings — System tab — Memory.

The Main tab displays the amount of memory the system
has allocated to file and data storage versus program
storage. This tab also displays the amount of memory in
use versus the available memory. For information about
making memory available, see Free Memory in Appen-
dix A.

The Storage Card tab displays how much memory is
available on the storage card that is inserted into your
device. If you have more than one card inserted, tap the
list box and then the name of the storage card whose
information you want to view.

The Running Programs tab displays the list of currently
active programs. You can stop a program by selecting itin
the list and tapping Stop. You may need to stop a program
if it becomes unstable or program memory is low.
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5.2

[ﬂ Power

@,; Tap m — Settings — System tab — Power.

B The Battery tab displays the amount of battery power
remaining. Battery power depends on the battery type
and how the device is being used.

B On the Advanced tab you can select options for turning
off your device to conserve battery power. To conserve
the most power, select the option that turns off the device
after 3 minutes or less.

Phone Settings

You can easily view and change settings, such as the ring
type and ring tone to be used for incoming calls, and the
keypad tone to be used when entering phone numbers. You
can also protect your phone from unauthorized use. There
are two ways to change phone settings:

i
o> o Tap p#] — Settings — Personal tab —
Phone.
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9 To change phone settings from the Phone keypad
— Tap Tools — Options — Phone tab

Sounds
a. Ring Type

You can change the way that you are notified of incoming
calls. For example, you can choose to be notified by a ring,
a vibration, or a combination of both.

f;) Tap the Ring type list, then select the desired
option.

b. Ring Tone

ra» Tap the Ring tone list, then select the sound you
want to use.

To use .wav, .mid, or .wma files as ring tones, use ActiveSync
on your PC to copy the file to the /Windows/Rings folder on
your device. Then, select the sound from the Ring tone list.

c. Keypad Tone

You can change the tone you hear when entering a phone
number on the keypad. If set to Tones, the tone is heard
continuously for as long as the number on the keypad is
pressed. If set to Beep, the tone is heard only for one or
two seconds.

r;} Tap the Keypad list, then select the option you
want.

To prevent tones from being heard when entering a phone
number, select Off.

e T
ol

ey G
ek Lo

| —

froracen Dorwit +[[8]w

=iy

L

| N -~

v
o
=
[
=]
3
=2
=
3
«Q




80 Pocket PC Phone User Manual

Services

Services settings on the Settings — Phone — Services tab
are primarily used to set options for incoming calls, such as
Call Forwarding, Call Waiting, and Caller ID.

Feature Function
Call Barring Enables you to block incoming and/or (ffpree e B

o
£
=
©
c
o
(7]
o
o
(-4

outgoing calls. S s
T T e P e, e
Caller ID Identifies caller by displaying their i M o e b

name and/or phone number.

Call Forwarding  Enables you to forward all or selected
incoming calls to a different number.

Call Waiting Notifies you of an incoming calls while
you're already on the phone .

rﬁ} Tap Get Settings to access the settings for a -
service.

To change service settings from the phone keypad,
“ tap Tools — Options — Services tab — tap a
service — Get Settings.

Network
With network settings, you can view available networks,
determine the order in which your phone accesses another m
network if the current one is unavailable, and specify whether e
you want to change networks manually or automatically. The =
current network will remain active until you change it, lose L e )
your signal, or change your SIM card. il o]
Sl i
oA m
B The network currently in use will be listed at S ——
U the top of the screen.
B When your current network is unavailable, tap
Select Network to select an alternate. P [ [t | =
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6.1

Microsoft®Pocket Outlook includes Calendar, Contacts,
Tasks, Inbox, and Notes. You can use these programs in-
dividually or together. For example, e-mail addresses stored
in Contacts can be used to address e-mail messages in
Inbox.

Using ActiveSync®, you can synchronize information
in Microsoft Outlook or Microsoft Exchange on your PC
with your device. You can also synchronize this information
directly with a Microsoft Exchange server. Each time you
synchronize, ActiveSync compares the changes you made
on your device and PC or server and updates both PC with
the latest information.

For information on using ActiveSync, see Chapter 4 Syn-
chronizing Information or ActiveSync Help on the PC.

E Calendar : Scheduling
Appointments and Meetings
Use Calendar to schedule appointments, including meetings
and other events. You can check your appointments in one

of several views (Agenda, Day, Week, Month, and Year) and
easily switch views by using the View menu.

L

You can customize the Calendar display, such
as changing the first day of the week, by tapping
Options on the Tools menu.

d
> O Tap to go to today.

e Tap to display or edit the appointment details.
e Tap to create a new appointment.

o Tap to change the first day of the week.

Tap here to switch to any of these
programs.
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To Create an Appointment

If you are in Day or Week view, tap the desired date and time

for the appointment, then tap New : eo
2 - ) . .
o o Tap tab appropriate fields, then using the input
panel, enter a description and a location. s =
i : (AR T na o]
e If needed, tap the date and time to change PO T T ] ] 1-:‘
them. i ;
S o 4]
@ Enter other desired information. You will need to i s )
hide the input panel to see all available fields. Frp e ey o
Lo, Y7 [T e =1
@ To add notes, tap the Notes tab. You can enter e
text, draw, or create a recording. For more
information on creating notes, see Notes: Se———— - =
el -

Capturing Thoughts and Ideas later in this

chapter. o I—e

e When finished, tap OK to return to the
calendar.

g If you select Remind me in an appointment, your

U device will remind you according to the options set

in E — Settings — Personal tab — Sounds &
Notifications.

Using the Summary Screen
Fﬁ) When you tap an appointment in Calendar, a m

summary screen is displayed. To change the [ey—y— &
appointment, tap Edit. L M M, 5L
[,

Syl wr e
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6.2

Creating Meeting Requests

You can use Calendar to set up meetings with users of
Outlook or Pocket Outlook. The meeting request will be
created automatically and sent either when you synchronize
Inbox or when you connect to your e-mail server. Indicate how
you want meeting requests sent by tapping Tools and then
Options. If you send and receive e-mail messages through
ActiveSync, select ActiveSync.

If you send and receive e-mail messages
through ActiveSync, select ActiveSync.

To schedule a meeting :
[—‘ o Create an appointment.

(2]
(3]

4]

Hide the input panel, and then tap Attendees.

Select the meeting attendees from the list of
e-mail addresses you've entered in Contacts.

The meeting notice is created automatically and
placed in the Outbox folder.

For more information on sending and receiving meeting re-
quests, see Calendar Help and Inbox Help on the device.

=

Contacts : Tracking
Friends and Colleagues

Contacts maintains a list of your friends and colleagues so
that you can easily find the information you are looking for,
whether you are at home or on the road. Using the device 's
infrared (IR) port, you can quickly share Contacts information
with other device users.
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‘ﬁ

©@ 06 ©0 0 ©

Select the category of contacts you want o
displayed in the list.

Tap and enter part of a name to quickly find it in
the list.

@
ol

Tap to see additional phone numbers and e-mail
addresses.

(o ]>)

Tap to display or edit the contact details.

(RN ERE RS

Tap and hold to display a pop-up menu of
actions.

HOSO.DIN

©
i
I
4
K
ms

Tap to create a new contact.

To change the way information appears in the list,
U tap Tools and then Options.

To create a contact :

J
= o Tap E — Contacts — New.

9 Using the input panel, enter a name and other
contact information. You will need to scroll down
to see all available fields.

9 To assign the contact to a category, scroll to and
tap Categories and select a category from the
list. In the contact list, you can display contacts
by category.

o To add notes, tap the Notes tab. You can enter
text, draw, or create a recording. For more
information on creating notes, see Notes:
Capturing Thoughts and Ideas later in this
chapter.

o When finished, tap OK to return to the contact
list.
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To Find a contact:

There are 6 ways to find a contact:

%

o Press and hold the top of the navigation pad

until alphabetical letters appear on the screen in
large type. Then use the navigation pad to scroll
through the alphabet and select a letter.

Tap one of the grouping of letters displayed
across the top of the screen.

In the contact list, enter a contact name in the box
under the navigation bar. To show all contacts
again, clear text from the box or tap the arrow
button to the right of the box.

In the contact list, tap the category list (labeled
All Contacts by default) and select the type of
contact that you want displayed. To show all
contacts again, select All Contacts. To view a
contact not assigned to a category, select No
Categories.

To view the names of companies your contacts
work for, in the contact list, tap View — By
Company. The number of contacts that work
for that company will be displayed to the right
of the company name.

s R -
B amw
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Usin
["G»

0 Tap E — Find, enter

the contact name,
select Contacts for
the type, and then tap
Go.

g the Summary Screen

When you tap a contact in the contact list, a
summary screen is displayed. To change the contact

information, tap Edit.

6.3 Tasks : Keeping a To Do

List

Use Tasks to keep track of what you have to do.

5

wy

To change the way information is displayed in the
list, tap Tools and then Options.
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To create a task :
J
2 o Tap E — Tasks — New.

il Tailin = L X
9 Using the input panel, enter a description. 7 [ [ 1o e it i 1
== Erpe——
LIRS )
o You can enter a start date and due date or enter O et
X other information by first tapping the field. If the N
8 input panel is open, you will need to hide it to
"g E see all available fields.
) , :
S o o To assign the task to a category, tap Categories
E i~ and select a category from the list. In the task
8 list, you can display tasks by category. e W
Q.

6 To add notes, tap the Notes tab. You can enter
text, draw, or create a recording. For more
information on creating notes, see Notes:
Capturing Thoughts and Ideas later in this
chapter.

o When finished, tap OK to return to the task list.

I To quickly create a task with only a subject, tap

U Entry Bar on the Tools menu. Then, tap Tap

here to add a new task and enter your task
information.

Using the Summary Screen

[2} When you tap a task in the task list, a summary screen vl Lt o =
is displayed. To change the task, tap Edit. : -
d & T ALY
i L'Eera )bl

ot §mte --
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6.4 [E Notes : Capturing
Thoughts and Ideas

Notes quickly capture thoughts, reminders, ideas, drawings,
and phone numbers. You can create a written note or a record-
ing, orinclude a recording in a note. If the note listis displayed,
it will be created as a stand-alone recording.

) 00I3NQO 19Xd0d
JOSoDIN

To create a note :
rﬁ} o Tap m — Notes — New.

9 Create your note by writing, drawing, typing,
and recording. For more information about
using the input panel, writing and drawing on the
screen, and creating recordings, see Chapter 2
Entering Information.
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7.1 About Connections @ga

You can set up connections to the Internet and to your corpo-
rate network at work in order to do such activities as browse
the Internet or intranet, send and receive e-mail and instant
messages, and synchronize information using ActiveSync.

Connections can be made using a modem, wireless network,
or network (Ethernet) card. Amodem connection can be used
to set up connections with an external modem, or through
your mobile phone network using a cellular line or GPRS.
You have the following connection options:

B Use the infrared (IR) port on your device to send and
receive files between two devices.

B Connect to your mobile Internet service provider (ISP)
and you can send and receive e-mail messages by using
Inbox and view Web or WAP pages by using Microsoft®
Pocket Internet Explorer. The communication software
for creating a wireless ISP connection is already installed
on your device. Your service provider will provide software
needed to install other services, such as paging and fax
services.

B Connect to the network at your company or organization,
and you can send and receive e-mail messages by using
Inbox and view Web or WAP pages by using Microsoft®
Pocket Internet Explorer, and synchronize with your
PC.

B Connect to your virtual private network (VPN) at the
company or organization where you work, where the
added security means that you can access the full re-
sources of your company’s network. For example, you
can use File Explorer to access the files of computers
on that network.

Your device has two groups of connection settings: My ISP
and My Work Network. My ISP settings are used to connect
to the Internet, and My Work Network settings can be used to
connect to any private network, such as the corporate network
you use at work. Simply fill in the settings and you'll be ready
to start connecting.
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7.2 Connect to the Internet

You can use GPRS to connect to your mobile ISP, and use
the connection to send and receive e-mail messages and
view Web or WAP pages.

Q} o Obtain the following information from your ISP:
ISP server phone number, user name, and
password.

O Tap ﬁ — Setting — Connections tab —
Connections

e In My ISP, tap Add a new modem
connection.

o Create a modem connection.

U Wireless connections can be made via a mobile

phone network or GPRS. If you are using a mobile

phone network to connect, in the Select a modem

list, tap Cellular Line. If you are using GPRS, tap
Cellular Line (GPRS).

e To start the connection, begin using the desired
program. For example, switch to Pocket Internet
Explorer and browse to a Web page. Your device
will automatically connect.

B To set up a network card or wireless network
U connection to your ISP, then add a new
connection under My Work Network.

B To change modem connection settings, in
either My ISP or My Work Network, tap
Manage existing connections. Select the
desired modem connection, tap Settings,
and follow the instructions on the screen.

U To view additional information for any screen,

tap e
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iﬂ CSD Line Type

This program allow you to choose the line type when you
make a circuit switch data connection.

The default setting on this device is customized

“ as the best setting for use. Don't change this
setting unless you have trouble on circuit switch
data connection.

To change a CSD Line Type:

r‘ o Tap E — Settings — Connections — then
CSD Line Type.

e Tap under Data rate and select a value, then tap
under Connection element and choose a type
from that drop-down menu. Tap OK.

% GPRS Settings

This program allow you to choose the GPRS setting method
when you make a GPRS connection. There 2 authentication
methods required to be set up :

m PAP authentication

Password Authentication Protocol, protocol used in
authentication which users clear text passwords and is
the least sophisticated of authentication protocols.

m CHAP authentication

Challenge Handshake Authentication Protocol, proto-
col used to negotiate the most secure form of encrypted
authentication supported by both server and client.

Changing these setting may cause your data

“ communications to no longer operate. Please
consult your service provider before altering
these settings.
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Set up a WAP gateway

To access WAP sites through Pocket Internet Explorer, con-
figure your device to use a WAP gateway. Use the following
steps to create a new set of connections to the Internet with
WAP gateway settings.

F‘ o Get the following information from your ISP :
ISP server phone number, user name, and
password. Also, contact your mobile phone
service provider and ask for your WAP gateway
server name and port number.

9 Tap m — Settings — Connections tab—
Connections — Tasks tab.

Tap Edit my proxy server. If a proxy server has
not been set up, tap Set up my proxy server.

o In Programs that automatically connect to the
Internet should connect using, tap New and enter
a name for the ISP connection.

© on the Proxy Settings tab, select This
network connects to the Internet and This
network uses a proxy server to connect to
the Internet.

0 If necessary, in the Proxy server box, enter the
proxy server name.

Tap Advanced.

(o I~

In the WAP box, enter the WAP gateway server
name. Under Port, enter the port number. The
most common WAP port number is 9201.

e Create a modem connection. Also, if necessary,
set dailing rules.
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7.3 @ Pocket Internet Explorer

Once connected, you can use Microsoft® Pocket Internet
Explorer to view Web HTML, cHTML, xHTML and WAP
pages. You can browse in either of these ways:

[.—
B During synchronization with your PC, download your | *= = =
favorite links and mobile favorites that are stored in the 'E,' R —
Mobile Favorites folder in Internet Explorer on the e

PC.

i To synchronize and download your favorite links
“ from your desktop computer, tap the sync option
Favorites in ActiveSync on your desktop PC.

B Connect to an Internet service provider (ISP) or network —r—
and browse the Web. To do this, you will need to create —-
the connection first, as described in section 7.2 Connect
to the Internet.

b
(=)}

£0
£ 2
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O 0
(o]

When connected to an ISP or network, you can also download
files and programs from the Internet or intranet.

To switch to Pocket Internet
Explorer :

D‘} Tap E — Internet Explorer.

You can use Pocket Internet Explorer to browse mobile
favorites and channels that have been downloaded to your
device without connecting to the Internet. You can also con-
nect to the Internet through an ISP or a network connection
and browse the Web/ WAP page(s).
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To browse the Internet :

Q (1
(=S o In the address bar that appears at the top of
the screen, enter the Web address you want to L
visit.

—O

Tap i‘? to go to the web address you entered.

Tap %7, the Favorites button, then tap the o

favorite you want to view. i
= ]
Tap ﬁ to go back to the Homepage you set. A v
PorhstPC.oom
Tap @ to refresh the web page on the [ T T

=—

Tap the arrow 4@ to choose from previously

®@ 06 00

9
entered addresses. g ®
o
s o S 3 B
To view mobile favorites and v 2
channels : E e

2
S o To display your list of favorites, tap ﬂ,? S PO N —
e Tap the page you want to view.

9 You will see the page that was downloaded the
last time you synchronized with your PC. If the
page is not on your device, the favorite will be
dimmed. To download the page to your device,
you will need to synchronize with your PC again,
or connect to the Internet to view the page.

e | |

u To add a favorite link while using the device, go
to the page you want to add, tap and hold on the
page, and tap Add to Favorites.
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The Mobile Favorites Folder
Only items stored in the Mobile Favorites folder in the [ E— =

Favorites folder in Internet Explorer on your PC will |= % === = &sassiil T
Jr— - | T A — ]

be synchronized with your device. This folder was cre- |- TR L s e piia
ated automatically when you installed ActiveSync. :

Favorite Links

During synchronization, the list of favorite links in the
Mobile Favorites folder on your PC is synchronized | I e —
with Pocket Internet Explorer on your device. Both -
your PC and your device are updated with changes |-
made to either list each time you synchronize. Unless |~ e
you mark the favorite link as a mobile favorite, only
the link will be downloaded to your device, and you | R
will need to connect to your ISP or network to view

the content. For more information on synchronization,
see ActiveSync Help on the PC.

Mobile Favorites

If you are using Microsoft Internet Explorer 5.0 or
higher on your PC, you can download mobile favor-
ites to your device. Synchronizing mobile favorites
downloads Web content to your device so that you
can view pages while you are disconnected from your
ISP and PC.

I
(=)}

£0
£ 2
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a. To create a mobile favorite :

Q} o In Internet Explorer on your desktop
computer, click Tools and then Create
Mobile Favorite.

9 To change the link name, enter a new
name in the Name box.

In Update, select a desired update
schedule.

Click OK. Internet Explorer downloads
the latest version of the page to your
desktop computer.

To limit the number of download links, :
open Internet Explorer on your desktop e
PC then Favorites.
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Move your mouse through Mobile Favorites to
the mobile favorite you want to change. Right-
click the mobile favorite and then Properties; in
the Download tab, specify 0 or 1 for the number
of linked pages you want to download.

e Synchronize your device and desktop computer.
Mobile favorites that are stored in the Mobile
Favorites folder in Internet Explorer are now
downloaded to your device.

U If you did not specify an update schedule in step

3, you will need to manually download content
to keep the information updated on your desktop
computer and device. Before synchronizing
with your device, open Internet Explorer on
your desktop computer, click Tools and then
Synchronize. You will see the last time content
was downloaded to the desktop computer, and you
can manually download content if needed.

g
5 @
3

2
Q35
o Qe
o

You can add a button to the Internet Explorer toolbar
for creating mobile favorites.

rﬁ) Open Internet Explorer on your desktop
computer — click View — Toolbars — and
then Customize.

b. Saving Device Memory

Mobile favorites take up storage memory on your device. To e —
minimize the amount of memory used: e e —

rﬁ} In ActiveSync on your desktop — click Options
— select Favorites — tap Settings and then

Customize. e T
You can then deselect Synchronize Images, Synchronize o sy
Sound and/or Synchronize offline content pages to stop o E

pictures and sounds, or some mobile favorites from being
downloaded to the device.
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Using AvantGo Channels

AvantGo is a free interactive service that gives you access to
personalized content and thousands of popular Web sites. You
can subscribe to AvantGo channels directly from your device.
Then, you synchronize your device and PC, or connect to the
Internet to download the content. For more information, visit
the AvantGo Web site http://avantgo.com/help.

To sign up for AvantGo :
r&} o In ActiveSync options on the desktop computer, T |

o

@ ] turn on synchronization for AvantGo. o e e
5} =il

£ 2 - P it

] E e Open Pocket Internet Explorer on your device, 3

O o then tap the Favorites button to display your list I"‘E“'" ==
o of favorites. o, Haad

- s
WL L
il

Follow the directions on the screen. You will need ]

W e e iy

o Tap the AvantGo Channels link.

to synchronize your device with your desktop
computer and then tap the My Channels button
to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Chan-

nels link in your list of favorites to see a few of the most Ty

popular channels. To add or remove channels, tap the Add Famrtr ]
or Remove link. =
3 T i

EBET
birals [wadi
W] b

e ]




Pocket PC Phone User Manual 101

7.4 [E] Terminal Services Client

Using the Terminal Services Client, you can log onto a Win-

dows NT server type PC that is running Terminal Services . v
software and use all of the programs that are available on wn i [
that PC from your mobile device. For example, instead of Lt e R b e,
running Microsoft Pocket Word, you can run the PC version o w
of Microsoft Word and access all of the .doc files on that PC g gt Py
from your device. = L_.|
werim Rl R
. You cannot use Transcriber when entering "';;' -
u information in Terminal Services. You must ‘5' L i
use Keyboard, Block Recognizer, or Letter i/ i
Recognizer. — .

To connect to a Terminal Server :

Start a remote connection to the server via your wireless
modem connection.

S
3 0
o Qe
o

[;} o Tap E — Programs — Terminal Services

Client. 5 et % e ©
[2)

If connecting to a server you have previously [—
connected used, tap its name in Recent I
Servers.

e To connect to a new server, enter the server’s
name in the Server box. Select the Limit size
of desktop to fit on the screen check box
only when using applications that have been
specifically sized for use with Pocket PC.

o Tap Connect.

If the network administrator has configured
Terminal Services Client to reconnect to
disconnected sessions, and you previously
disconnected from a Terminal Server without
ending the session, the Terminal Services Client
reconnects to that session.

For more information about the connection of Terminal Ser-
vices Client, tap E — Help.
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7.5 ~§ Wireless Modem

This utility will simulate your device as a wireless modem, and
let your PC/Notebook be connected to a wireless network.
Before creating a new modem via selected connection type,
you still need to install the drivers on your PC/Notebook. For
more details about the drivers installation and the minimum
requirements of your PC/Notebook, please refer to Pocket
PC Phone 2003 Companion CD.

[—G} o Tap ﬁ — Programs — then tap Wireless
Modem.
3 Select a connection type :
Connect your device via Fesit
infrared or serial to a note- K
book or PC, and then tap [phustact

Start.

Before you press the Start button, please make sure your
device is with a GPRS SIM card and you have connected this
device to your PC/Notebook by Serial or IrDA connection and
disabled the Activesync.

&3 Bluetooth

Bluetooth is a short-range wireless communications tech-
nology. Devices with Bluetooth capabilities can exchange
information over a distance of about 10 meters without
requiring a physical connection.

Unlike infrared, you don't need to line up the devices to beam
information with Bluetooth. The devices only need to be within
arange of about 10 meters. You can even beam information
to a device in a different room, as long as it's within range.
The software included with your Pocket PC Phone allows you
to use Bluetooth in the following ways :

B Beam information, such as files, appointments, tasks,
and contact cards, between devices that have Bluetooth
capabilities. For example, if you and a co-worker each
have a device with Bluetooth, you can beam items
between your devices, such as files, contact cards, ap-
pointments, tasks, and so forth.

B Create a dial-up modem connection between your
device and a Bluetooth phone. You can then use the
Bluetooth phone as a modem.

v sk na Ee i
e R e e
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Bluetooth modes

Bluetooth operates in three different modes:

a. On

The Bluetooth radio is turned on and you can use Bluetooth
features.

b. Off

The Bluetooth radio is turned off. In this mode, you can neither
send nor receive information by using Bluetooth. You might
want to turn the radio off at times in order to conserve bat-
tery power, or in situations where radio use is prohibited, for
example on airplanes and in hospitals.

To turn your Bluetooth on or off:

[_G} o Tap E — Setting — Connections tab
© Tap Bluetooth.

9 Select On or Off. The Bluetooth radio is turned
on or off according to your selection.

By default the Bluetooth radio is turned off. If

U you turn it on, and then turn off your device,
the Bluetooth radio also turns off. When you
turn on your device again, the Bluetooth radio
automatically turns on .

c. Discoverable

The Bluetooth radio is turned on, and all of the other Bluetooth
devices within range (about 10 meters) can detect your device
and attempt to beam information to it, establish a bond, or use
a Bluetooth service. In this mode, other devices can detect
your device whether or not a bond has been created; however,
in order to receive a beam from another device, you must ac-
cept it on your device. To make your device discoverable:
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[a} o Tap E — Setting — Connections tab
@ Tap Bluetooth.
o Select Discoverable.

Other Bluetooth devices can now detect your device and
attempt to beam information to it, establish a bond, or use a
Bluetooth service. Note that to receive beamed information,
you must accept it on your device.

Selecting Discoverable also turns on your
Bluetooth radio.

If you no longer want your device to be discoverable, tap Off
to turn off the radio or On to leave the radio on, but not allow
detection by other devices.

Bonds

Abond is a relationship that you create between your Pocket
PC and another Bluetooth device in order to exchange infor-
mation in a secure manner. Creating a bond involves entering
the same personal identification number (PIN) on the two
devices you want to bond. You need only create a bond once
between two devices. Once a bond is created, the devices
recognize the bond and are able to exchange information
without your entering a PIN again.

a. To create a Bond :

You can create a bond between your device and another de-
vice that has Bluetooth. Once you do this, Bluetooth doesn’t
need to be in discoverable mode in order for you to beam
information between the two devices; the Bluetooth radio only
needs to be turned on.

[2} o Make sure that the two devices are within 10
meters of one another and that Bluetooth is in
discoverable mode on both devices.

@ Tap E — Settings — Connections tab.

—
Tep——p—r—— ——p———
bt o iy
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O

Tap Bluetooth — Bonded Devices tab — New.
Your device searches for other Bluetooth devices
and displays them in the list.

Tap the name of the other device in the list, and
then Next.

G

In PIN, enter a PIN of between 1 and 16
characters and tap Next.

Enter the same PIN on the other device.

If you want, in Name, edit the name of the other
device.

© 00 O O

Tap Finish.

g
5 @
=
o=
Q35
Qe
o

b. To accept a Bond :

[2} o Make sure that Bluetooth is turned on and in
discoverable mode.

9 When prompted to bond with the other device,
tap OK.

© in PIN, enter a PIN of between 1 and 16
characters, and tap Next. You must enter
the same PIN that was entered on the device
requesting the bond.

s o gt i s o] Wi

o If you want, in Name, edit the name of the device
requesting the bond.

Lo i .l.l.. -\:. 1

© Tap Finish.

The bond is created. You can now exchange information with
the other device.
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c. To rename a Bond :

@; o Tap ﬁ — Settings — Connections tab.
@ Tap Bluetooth — Bonded Devices tab.
9 Tap the bond to rename.
o In Name, enter a new name for the bond.
© Tap Finish.

d. To delete a Bond :

@} o Tap ﬁ — Settings — Connections tab.
9 Tap Bluetooth — Bonded Devices tab.

9 Tap and hold the bond to delete.
o Tap Delete.

Beaming Information with
Bluetooth

mﬁ} n Tap and hold an item to beam, such as an
appointment in Calendar, a task in Tasks,
a contact card in Contacts, or a file in File
Manager.

@ Tap Beam [type of item].

o Tap the device to which you want to send the
beam.

The item is beamed to the device you selected.

If the device that you want to beam to doesn’t

u appear in the list, make sure that it is turned on,
in discoverable mode, and within 10 meters (10
meters) of your device. Also, make sure that your
Bluetooth radio is turned on.
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Receiving a Bluetooth Beam
F‘ Make sure that your device is configured to
receive incoming beams and that Bluetooth is
in discoverable mode.

Make sure that your device is within 10 meters
of the device beaming the information.

9 When prompted to receive an incoming beam,
tap Yes.

The information is now stored on your device.

Using a Bluetooth Phone as a
Modem

You can use a phone that has Bluetooth capabilities as a mo-
dem for your device. To do this, you create a Bluetooth modem
connection on your device and then send information to the
phone by using Bluetooth. The phone relays the information
over the phone line and then sends back to your device any
information that you had requested over the connection.

Once you create a modem connection to the Bluetooth phone,

you can reuse it whenever you want to use the phone as a

modem.

ré) o Make sure that the Bluetooth phone is turned
on, that your device’s and the phone’s Bluetooth
radios are turned on, and that your device and
the phone are within 10 meters (10 meters) of
one another.

If you have not already done so, create a
Bluetooth phone connection by following steps
3 through 16. Otherwise, skip to step 17.

Tap m — Settings — Connections tab.

Tap Connections —» Add a new modem
connection.

Enter a name for the connection.

@0 600 O

In the Select a modem list, tap Bluetooth —
Next.
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® 6 & 866 ®6 60 O

Make sure that the phone is discoverable. Some
phones may also need to be pairable in order to
accept a bonding request. For more information,
see your phone documentation.

If the phone appears in the My Connections
list, skip to step 14. If not, tap New and follow
the remaining steps.

In the list, tap the phone and then Next.

In PIN, enter a PIN of between 1 and 16
characters, and tap Next.

Enter the same PIN on the phone.

If you want, in Name, edit the name of the
phone.

Tap Finish.

In the My Connections list, tap the phone, and
then Next.

Enter the phone number to dial for this connection
and tap Next.

In User name, Password, and Domain, enter
the logon information for this connection and tap
Finish.

Start using the program that uses the Bluetooth
phone connection; for example Inbox to send
and receive e-mail, or Internet Explorer to
browse the Web.
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8.1 @ E-mail Messages : Using Inbox

You can set up a connection to an e-mail server so that you
can send and receive e-mail messages by using a modem or
network connection and Inbox on your device.

L

You can use multiple e-mail services to receive your mes-
sages. For each e-mail service you intend to use, first set
up and name the e-mail service. If you use the same service
to connect to different mailboxes, set up and name each
mailbox connection.

The ISP or network must use a POP3 or IMAP4
e-mail server and an SMTP gateway.

To set up an e-mail service :

Q} o Open Inbox on your device, tap Accounts, and
then New Account. Follow the directions in the
New Account Wizard.

9 Fill in you e-mail address then tap Next.

Next will initiate auto-configuration which
attempts to connect your Pocket PC Phone to
your e-mail server and automatically download
the necessary e-mail connection settings.

L

B |f auto-configuration is successful you
can immediately begin sending/receiving e-
mails.

B [f auto-configuration is unsuccessful you will
need to manually enter the settings.

e Lo = A

[ (R -
[RT—— !
L L
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0 Enter Your name, User name and Password, m
then tap Next. | s ey {1

@ From the drop down menu select the Account m
type that your e-mail provider supports (POP3 b ol ey i W

or IMAP4)- e
fae R |
e Enter a Name for your e-mail account then tap L
Next.

so.lnjesd]

2
o
]
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5
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0 Enter the your e-mail provider’s server name m

information for Incoming mail and Outgoing mail,
then tap Finish. When finished, to connect to "":H":_]' = |
your e-mail server, tap Accounts and then 'h‘_‘_] [
Connect. T ——}
- |
u For an explanation of a screen, tap i and then [t—am—m 3]
Help. " . e »
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Sending and Receiving E-mail

You can use Inbox to send and receive e-mail messages in
either of these ways:

B Synchronize e-mail messages with Microsoft Exchange
or Microsoft Outlook on your PC.

B Connect directly to an e-mail server through an Internet
service provider (ISP) or a network.

You also can use Inbox to send and receive SMS; it supports
8 bits of data with class 0, 1, 2, 3, and Unstructured Supple-
mentary Service Data (USSD) as well.

a. Synchronizing E-mail Messages

E-mail messages can be synchronized as part of
the general synchronization process. You will need | ==ums===r== -
to enable Inbox synchronization in ActiveSync. For
information on enabling Inbox synchronization, see

ActiveSync Help on the PC. m

During synchronization: Ee=1

B Messages are copied from the mail folders of Ex- et
change or Outlook on your PC to the ActiveSync

folder in Inbox on your device. By default, you will
receive messages from the past five days only, and
the first 100 lines of each message.

B E-mail messages in the Outbox folder on your device are
transferred to Exchange or Outlook, and then sent from
those programs.

E-mail messages in folders must be selected in ActiveSync
on your PC in order to be transferred
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b. Connecting Directly to an E-mail Server

B Once your e-mail account is set up and you're connected,
new messages will be downloaded to the device's Inbox
folder, and messages in the device Outbox folder will be
sent.

B When you delete a message on your device that was
downloaded from your e-mail server, it will also be deleted
from the e-mail server the next time you connect.

B You can work online or offline. When working online, you
read and respond to messages while connected. Mes-
sages are sent as soon as you tap Send, which saves
space on your device.

B When working offline, once you have downloaded new
message headers or partial messages, you can dis-
connect from the e-mail server and then decide which
messages to download completely. The next time you
connect, Inbox downloads the complete messages you
have marked for retrieval and sends the messages you
have composed.

c. Using the Message List

“z
o 0
a 0
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frerd
B Messages you receive are displayed in the message = [ —
list. By default, the most recently received messages 1:11 Mg -
are displayed first in the list. AT T 3;1-;1;';
e ELRCRR L

mE L

[T il Rt

B When you receive a message, tap to open it. Unread
messages are displayed in bold.
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c. Using the Message List (Cont'd)

B You can mark the messages that you want to retrieve
in full during your next synchronization or e-mail server
connection. In the message list, tap and hold the message
you want to retrieve. On the pop up menu, tap Mark for
Download. The icons in the Inbox message list provide
visual indication of message status.

B Specify your downloading preferences when you set up
the service or select your synchronization options. You
can change them at any time:

o Change options for Inbox synchronization using

ActiveSync options. For more information, see E:.:E»;F:T [ B
ActiveSync Help.

o Change options for direct e-mail server connections
in Inbox on your device. Tap Tools and then tap Op-
tions. On the Account tab, tap the service you want
to change. Tap and hold the service and select Delete
to remove a service.

d. Creating an E-mail message

= @ [:) @ Tap New.

g 5 9 In the To field, enter either e-mail address of

] ® one or more recipients, separating them with | -

g I}_’ a semicolon, or select a name from the contact 1

list by tapping the Address Book El button. All
e-mail addresses entered in the e-mail fields in
Contacts appear in the Address Book.

SMS messages can be sent by entering the SMS
numbers in the To field.

o Compose your message. To enter preset or w8 | ]
frequently used messages, tap My Text and it vy et [ L
select a message.

o Tap [.:.] button when you have finished the
message. If you are working offline, the message
is moved to the Outbox folder and will be sent
the next time you connect.
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. Swap between e-mail accounts and SMS by
U tapping Account.

8.2 @ SMS Messages

SMS messages can be sent in two ways :

B Go to Inbox, open a new e-mail message and select
SMS account in the Account type options.

B Oryou candirectly send in phone dialer in the Tools menu
bar.

To send SMS in phone dialer :

d

= o In phone dialer screen, tap Tools, and then
Send SMS. A new message screen appears in
Inbox.

9 In the To field, enter the SMS number of one
or more recipients, separating them with a
semicolon, or select a name from the contact
list by tapping the Address Book [I=] button.

e Compose your message. To enter preset or
frequently used messages, tap My Text and
select a message.

o Tap | when you have finished the message.
If you are working offline, the message is moved
to the Outbox folder and will be sent the next
time you connect.

g SMS cannot be used to send e-mail messages.

U You can tap the double arrows next to the subject

field to show the complete header. From the
Account list, select an e-mail account.

If you are sending an SMS message and want to
U know if it was received, tap Edit, Options, and

select Request SMS text message delivery

notification before sending the message.

saJinjead
buibessap
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8.3 f% MSN Messenger : Instant

Messaging : E—

MSN®Messenger on your mobile device is an instant mes-

saging program that lets you:
g by o -

B See who is online.

B Send and receive instant messages. { {
B Have an instant message conversations with groups of
contacts. M
B Notifies contacts of your on-line status. =T -

B Block contacts from seeing your status or sending you
messages.

To use MSN Messenger, you must have a Microsoft Pass-
port ™ account or a Microsoft Exchange e-mail account.
Once you have obtained one of these accounts, you are
ready to sign in to MSN Messenger.

If you have a Hotmail ® or MSN account, you
“ already have a Passport.
B To set up a Microsoft Passport account, go
to hitp://www.passport.com
B To set up a Hotmail account, go to
http://www.hotmail.com

Features
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To switch to MSN Messenger : - . -
[a) Tap ] — Program — MSN Messenger 2 ¥
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Setting Up and Signing In
[—“ o Connect to the Internet using any methods

outlined in Chapter 7 Getting Connected.

1 g Byt By g -\.

9 Tap anywhere on the MSN Messenger screen, M
enter your sign-in name and password then tap Mesttnger Sarvice
Sign in. TR =
[T—r— -.-

Or tap Tools — Options — Accounts tab to
set your sign-in name and password by selecting
Enable MSN Messenger Service

U Your sign-in name is usually in the form :
username@domain.com .

: If you already use MSN Messenger on your PC,
U your contacts will automatically appear on your
device.

saJinjead
buibessap

Working with Contacts

The MSN Messenger window displays all of your messen- 1, i

ger contacts at a glance, divided into Online and Not Online -%T“
categories. From this view, while connected, you can chat, -
send e-mail, block a contact from chatting with you, or delete s B it
contacts from your list using the pop-up menu. i

g To see others online without being seen, open the
U Tools menu, tap My Status and select Appear
Offline. If you block a contact, you will appear
offline but will remain on the blocked contact’s list.
To unblock a contact, tap and hold the contact,

then tap Unblock on the pop up menu.

Tap and hold to display a pop-up
menu of actions
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Chatting with Contacts

Tap a contact name to open a chat window. Enter your mes-
sage in the text entry area at the bottom of the screen, or tap
My Text to enter a preset message, then tap Send. To invite
another contact to multi-user chat, open the Tools menu, tap
Invite then tap the contact you want to invite.

Tap to send message

Enter message here. —{™ = r =l = E

To know if the contact you are chatting with is responding,
look for the message under the text entry area.
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View status of the chat.

For more information on using MSN Messenger, tap E
and then Help.
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8.4 E',} MMS Messages

With MMS Composer, you can create and share your own
MMS messages, complete with photos, videos, text, and
audio.

To access MMS Composer:

fé; o Tap E — Programs — MMS Composer.

e The Today screen offers another way
of accessing MMS Composer. You are
automatically notified on this page if you have
any new messages. All you need to do is tap
the MMS messages line and the program will
launch.

Message Boxes

To view message folders:

When the program starts, it will take you to your message box-
es. Use the pull-down to select the one you wish to view.

To view message options: s =
Within each message box, you can tap and hold on an indi- Q a
vidual message to see various options c 8
3
Options Explanations Q
New Creates a new message.
Delete Removes the message.
Reply Lets you respond to the message by send-
ing one of your own.
Reply All Responds to everyone included in the
initial message.
Forward Sends the message to someone else.
Mark as Makes the message appear as if it is a
Unread newly received message.

Message Info | Displays various message information,
such as the sender, the subject, the date
and time it was sent, and the size.

S T -‘
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To view and alter program settings:

S

o Tap Tools — Options — Preferences tab .You

o Tap m — Programs — MMS Composer.

have the following options:

Options Explanations

Connect Via | Select your type of Internet connection = pmna

from the pull-down list. o I'F* =l

Frim= ¥ -

Connect to Select your wireless server here. - .-._.,: [T ep—
Server I =
Retrieve Typically, you receive a notification when-
Messages ever a new message is available. Check-
Immediately | ing this box bypass the notification and

download new messages automatically.
Size Limita- You can sent the maximum size limit for m
tions messages that you send and receive. . Bt e e 1
No. of This value sets the number of times the
attempts be- | program will attempt to send your mes- o }..:
fore aborting | sage before stopping.

Vaw b o owr? i o sl i

Creating a Message

Messages are created by combining various slides. Each
slide can consist of a photo or video, audio, and text.

Features
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To add a picture or video clip:

(3} &
= o Tap the blue box to select a specific location that
contains photos/videos. |

9 Choose either Photos or Videos from this pull-
down. You can only add either a single photo
or video clip to each individual slide.

o Tap the specific photo or video clip that you want
to add, then tap Select.

o To take a new picture or video clip press the
Camera icon [#l. The picture or video clip will
be automatically inserted.




Pocket PC Phone User Manual

121

To add text:

You can add text to any slide. You can either enter in new
text with the keyboard, or use “canned” text. Canned text are
previously saved words or phrases.

(P2}
‘} Tap in the Insert text here box then enter the text
you want to send.

To insert canned text:

J .

& @ Tap and hold in the Insert text
here box until a menu pops
up..

9 Tap Insert canned text from the
pop-up menu.

o Select a phrase from the list and
tap Select.

o To add new, edit or delete o
existing canned text, tap and
hold on the canned text screen.

To add audio clips:

Single audio clips can be added to each slide. You can either
include an existing sound file, or record a new one.

o Tap in the Tap here to insert an audio clip

[2» box.

From the drop-down menu select a location that
contains audio files.

Preview the audio files by tapping on them. Use
the toolbar below to Stop and Play the file.

To insert the clip tap . Otherwise, tap .

®0 O O

To record a new audio clip tap the Record

icon, then tap Iﬂ to start recording and to
finish. The clip will be automatically inserted.
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Menu Commands

The following commands are available along the bottom of
the screen:

S @ Edit

Edit Tools (s =60 (4] (]

XX

' XC)

New Slide To add a new slide, tap Edit, then New Slide.

Delete Slide To delete a slide, tap Edit, then Delete Slide..

to their new positions.

Organize Slides To change the order of the slides in a message, tap Edit,
Organize Slides..., then use your stylus to drag the slides

Save in Drafts To save as a draft, tap Edit, Save in Drafts

9 Tools

Send Message To send your message when you're ready (same as El )

Preview Message | previews your message (same as | =] )

9 - Previews your message (as mentioned
directly above).

o El - Tap here when you're ready to send your
message.

6 - These buttons let you navigate through

the various slides in your message.

Viewing a Message

You have several options when viewing a message that
you receive:

@} o Use the playback controls (Play/Pause, Stop)
to view the message. You can pause it anytime
during playback.
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9 Tap Objects to see a list of each file. If you'd

like to save a particular file, tap it, then choose “
Save from the Tools menu - =

B & issusa i

[ [ yr—p— -

[Fe [y -

= — =

. L

e You can also view the message
components manually. Use the
navigation buttons to scroll through the
message. Use the options in the Save
menu to save individual components
you like.

so.injesd]

Sending a Message

2
o
]
]
o
=
5
[}

Now that you've finished creating your message and you've
tapped the Send button, all you need to do is enter a little
bit of information:

[ZP o Enter in the recipient’s phone number — Tap To T
Phone to see your phone book. | T =
[Te b
9 Enter in the recipient’s e-mail address — Tap |--.-—u-.=r--- |
To E-mail to see your address book. ~errs
riwrg |
e Enter in a subject of your message. = ]
g s
adar § amsane
o When you're ready, tap Send. Otherwise, tap el ik
Cancel.
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8.5

Sending Options

B To manually set the date and time you want the message
sent, uncheck the Send the message now box.

B To select how long you would like the message stored on
the server, tap next to Expiration. The server will stop at-
tempting to deliver the message once the time expires.

B To hide your identity, check the Send anonymously
box.

B To change the resolution of a message, tap under Photo
Resolution.

Managing Messages and
Folders

By default, messages are displayed in one of five folders for
each service you have created: Inbox, Deleted Iltems, Drafts,
Outbox, and Sent Items. The Deleted ltems folder contains
messages that have been deleted on the device. The behavior
of the Deleted and Sent Items folders depends on the options
you have chosen. In the message list, tap Tools and then
Options. On the Message tab, select your options.

To organize messages into additional folders, create new
folders by tapping Tools, then Manage Folders. To move a
message to another folder, in the message list, tap and hold
the message and then tap Move to on the pop up menu.

Folder behavior with a direct
connection to an e-mail server

The behavior of the folders you create depends on whether
you are using ActiveSync, SMS, POP3, or IMAP4.
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B If you use ActiveSync, e-mail messages in the Inbox
folder in Outlook will automatically be synchronized with
your device. You can select to synchronize additional
folders by designating them for ActiveSync. The folders
you created and the messages you moved will then be
mirrored on the server. For example, if you move two
messages from the Inbox folder to a folder named Family
and you have designated Family for synchronization, the
server creates a copy of the Family folder and copies the
messages into that folder. You can then read the mes-
sages while away from your PC.

B If you use SMS, messages are stored in the Inbox folder
of SMS category.

B If you use POP3 and you move e-mail messages to a FEeeEETTY

folder you created, the link is broken between the mes- e

sages on the device and their copies on the mail server. e

The next time you connect, the mail server will see that '.'a_"_'_ o

the messages are missing from the device Inbox and de- .?.-,Im ;

lete them from the server. This prevents you from having Sl

duplicate copies of a message, but it also means that you ey S =2

will no longer have access to messages that you move
to folders created from anywhere except the device.

so.injesd]

o
]
]
o

=
5
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B If you use IMAP4, the folders you created and the e- m

mail messages you moved are mirrored on the server. s eweed ma s
Therefore, messages are available to you anytime you - ferreg

connect to your mail server, whether it is from your device " e e

or PC. This synchronization of folders occurs whenever "'.,‘,1:

you connect to your mail server; create new folders, or -

rename/delete folders when connected. ) mory
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Companion Programs

- 9:1-Pocket:Word——
——————9.2-Pocket-Excel——
~9:3-Windows:Media:Player——
— 9.4-Microsoft-Reader——
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9:5-Pictures——
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Companion programs consist of Microsoft® Pocket Word, m
Microsoft® Pocket Excel, Windows Media Player for ¥

- - [
- . e Tempeeaps  [edmle
?ocket PC, and Microsoft® Reader and Pictures. o =] ,‘!
& To switch to a companion program on your device, Friwm felel fel Fpdei
tap Programs on the E menu, and then tap the = L—l
program name. i P Y
[ T

9.1 |W] Pocket Word T i

Pocket Word works with Microsoft Word on your PC to give
you easy access to copies of your documents. You can create
new documents on your device, or you can copy documents
from your PC to your device. Synchronize documents between
your PC and your device so that you have the most up-to-date
content in both locations.

To create a new file : (B s T gl O

J
o> 0 Tap E — Programs — Pocket Word — and
then New. A blank document appears.

e If you have selected a template for new
documents in the Tool — Options dialog box,
that template appears with appropriate text and ..

e = d ar s

formatting already provided. rd
b |-

You can open only one document at a time; when m

you open a second document, you will be asked
to save the first. You can save a document you
create or edit in a variety of formats, including
Word (.doc), Pocket Word (.psw), Rich Text
Format (.rtf), and Plain Text (.txt).
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Pocket Word contains a list of the files stored on your device.
Tap a file in the list to open it. To delete, make copies of, and
send files, tap and hold a file in the list. Then, select the ap-
propriate action on the pop up menu.
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‘T]

® 0600 ©

Select the folder type you want displayed in the
list.

Tap to change the sort order of the list.
Tap to open a document.

Tap and hold an item to see a pop-up menu of
actions.

Tap to create a new documents.

You can change the zoom magnification by

u tapping View and then Zoom. Select a higher
percentage to enter text and a lower one to see
more of your document.

If you are opening a Word document created on
U a PC, select Wrap to Window on the View menu
so that you can see the entire document.

Entering Information in a New File

You can enter information in Pocket Word in one of four
modes (typing, writing, drawing, and recording), which are
displayed on the View menu. Each mode has its own toolbar,
which you can show and hide by tapping the Show/Hide
Toolbar button on the command bar.

a. Typing Mode

B Using the input panel, enter typed text into the document.
For more information on entering typed text, see Chapter
2.

sweuabouid
uojuedwo)

B To format or edit existing text, first select it by using your
stylus to drag through the text. You can search a docu-
ment for text by tapping Edit and then Find/Replace.
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Entering Information in a New File
(Cont'd.)

b. Writing Mode

In writing mode, use your stylus to write directly on the screen.
Ruled lines are displayed as a guide, and the zoom magni-
fication is greater than in typing mode to allow you to write
more easily. For more information on writing and selecting
writing, see Chapter 2.

u If you cross three ruled lines in a single stylus

stroke, the writing becomes a drawing and can
be edited and manipulated as described in the
following section.

Written words are converted to graphics (metafiles)
when a Pocket Word document is converted to a
Word document on your PC.

c. Drawing Mode

In drawing mode, use your stylus to draw on the screen.
Gridlines appear as a guide. When you lift your stylus off
the screen after the first stroke, you'll see a drawing box
indicating the boundaries of the drawing. Every subsequent
stroke within or touching the drawing box becomes part of
the drawing. For more information on drawing and selecting
drawings, see Chapter 2.

d. Recording Mode

In recording mode, you can embed a recording into your
document. Recordings are saved as .wav files. For more
information on recording, see Making a Recording in Chap-
ter 2. For more information on using Pocket Word, tap
and then Help.
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9.2

2% Pocket Excel

Pocket Excel works with Microsoft Excel on your PC to
provide easy access to copies of your workbooks. You can
create new workbooks on your device, or you can copy work-
books from your PC to your device. Synchronize workbooks
between your PC and your device so that you have the most
up-to-date content in both locations.

To Create a new Pocket Excel File

F‘ o Tap — Programs — Pocket Excel — and
then New. A blank workbook appears.

9 If you have selected a template for new
workbooks in the Options dialog box, that
template appears with appropriate text and
formatting already provided.

Pocket Excel provides fundamental spreadsheet tools, such
as formulas, functions, sorting, and filtering. To display the
toolbar, tap View and then Toolbar.

You can open only one workbook at a time; when
you open a second workbook, you will be asked
to save the first. You can save a workbook you
create or edit in a variety of formats, including
Pocket Excel (.pxl) and Excel (.xIs).

wy

If your workbook contains sensitive
information, you can protect it with a
password. To do so, open the workbook; tap
Edit, and then Password. Every time you open
the workbook, you will need to enter the password,
so choose one that is easy for you to remember
but hard for others to guess.
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Tips for Working in Pocket Excel

Note the following when working in large worksheets in

Pocket Excel: m
[ el B T

_— S T T [T L T
B View in full screen mode to see as much of your worksheet s
L}

as possible. Tap View and then Full Screen. To exit full
screen mode, tap Restore.
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B Show and hide window elements. Tap View and then tap
the elements you want to show or hide.

B Freeze panes on a worksheet. First select the cell where
you want to freeze panes. Tap View and then Freeze
Panes. You might want to freeze the top and leftmost
panes in a worksheet to keep row and column labels
visible as you scroll through a sheet.

B Split panes to view different areas of a large worksheet.
Tap View and then Split. Then drag the split bar to where
you want it. To remove the split, tap View and then Re-
move Split.

B Show and hide rows and columns. To hide a hidden row
or column, select a cell in the row or column you want to v T
hide. Then tap Format, then Row or Column, and then
Hide. To show a hidden row or column, tap Tools, then
Go To, and then type a reference that are in the hidden
row or column. Then tap Format, then Row or Column,
and then Unhide.
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9.3 @ Windows Media Player for
Pocket PC

Use Microsoft Windows Media Player for Pocket PC to play
digital audio and video files that are stored on your device or
on a network. To switch to Windows Media Player for Pocket

PC, tap ﬁ — Windows Media.

[2} Use Microsoft Windows Media Player on your PC
to copy digital audio and video files to your Pocket
PC. Your Pocket PC can play Windows Media and
MP3 files.

For more information about using Windows Media Player for
Pocket PC, tap ﬁ — and then tap Help.

Yirclin

'q.;'-
9.4 I‘J Microsoft Reader

Use Microsoft Reader to read e-Books on your device.
Download books from your favorite e-Book web site to your
PC, then use ActiveSync to copy the files to your activated
device. To open a book, tap it's title in the MS Reader Li-
brary.

B To switch to Microsoft Reader, tap ﬁ — Programs, and
then — Microsoft Reader.

B Page through the book by using the Up/Down control
on your device or by tapping the page number on each
page.

B Annotate the book with highlighting, bookmarks, notes,
and drawings.
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B Search for text and look up definitions for words.

B The Guide-book contains all the information you need
to use the software. To open the Guide-book, tap Help

B Reader command bar. Or, on a book page, tap and hold on
the book title, and then tap Help on the pop up menu.
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Getting Books on Your Device

You can purchase and download book files from the Web to

: : [EE—— =
your PC and then synchronize them with your Pocket PC. S
However, before you can do this, you must -
) ) * 5 i s, e debir b
B Activated your device e S e |
B Have an activated copy of MS Reader on your PC i-I _-
=
B Set up synchronization for Files in ActiveSync. I:E--_ )
| A o
[2} o Open ActiveSync on your PC — then check that == ___T:::___'_ i
you have selected synchronize Files. If you have L i i DS,
done so it will appear under Information Type; .. .. :
if you have not, click Options, Sync options LA ), ==

— tap Files and then OK from the pop-up
menu. (The pop-up menu is telling your
computer will create a folder in which you
must put files you wish to synchronize)

9 If you have not already activated your
device, open your web browser, go to

http://das.Microsoft.com/activate and
follow the instructions.

o Go to www.microsoft.com/reader/shop.asp for
a list of retailers selling MS Reader e-Books.

o If you do not have a copy of MS Reader on
your PC, go to one of the retailers listed above
and download a free copy from their site; then
activate it as described above.

o Go to one of the MS Reader e-Book sites, and
follow the instructions for choosing, purchasing
and downloading a book to your desktop.
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0 Use Windows Explorer on your desktop to
locate the MS Reader’s My Library folder —
and the Pocket_PC My Documents folder. Find
the book title in My Library — and then copy it
to Pocket_PC My Documents. ActiveSync
will then download the files from your PC to your
activated device.
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Sample books and a dictionary are also included in the MS
Reader folder in the Extras folder on the Pocket PC Com-
panion CD.

Using the Library

The Library, your MS Reader home page, displays a list of all
books stored on your device or storage card.

a. To open the Library :
[2) o Tap E — Programs — Microsoft Reader.

9 On a book page, tap the book title, and then tap
Library on the pop up menu.

b. To open a book :

[2} Tap its title in the Library list.

Reading a Book

B Each book consists of a cover page, an optional table of
contents, and the pages of the book. Navigation options
are listed in the bottom portion of the cover page.

B Subsequently, whenever you open the book, you'll be
automatically taken to the last page read.

B |n addition to the text, each book page includes a page
number and book title.
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B Page through a book by using the Up/Down control on
your device.
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Using Reader Features

Reading a book electronically gives you several options not
available with paper books. These options are available from
any book page.

Wy

Select text by dragging across the text on the page. Then,
tap an option on the pop up menu, as described below:

Search for Text. Find text in a book by tapping Find on
the pop up menu. Enter the word you want to search for,
and tap the desired Find option. Reader highlights found
text on the page. To close Find, tap outside the box. To
return to your original page, tap the title and then tap
Return on the pop up menu.

Copy Text. You can copy text from books that support
this feature into any program that accepts text. On a book
page, select the text you want to copy. Then, tap Copy
Text on the pop up menu. The text can be pasted into
the program of your choice.

Bookmarks. When you add a bookmark to a book, a
color-coded bookmark icon appears in the right margin.
You can add multiple bookmarks to a book. Then, from
anywhere in the book, tap the bookmark icon to go to the
bookmarked page.

notes you have made.

Highlights. When you highlight text, it appears with a
colored background.

When you attach a note to text, you enter the text
in a note pad that appears on top of the book page.
A Note icon will display in the left margin. To show
or hide the note, tap the icon.
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B Drawings. When you add a drawing, a Drawing icon ap-
pears in the bottom-left corner of the page, and drawing
tools appear across the bottom of the page. Draw by
dragging your stylus.

B To see a list of a book’s annotations, including book-
marks, highlights, text notes, and drawings, tap Go to —
Annotations Index on the book’s cover page. You can
tap an entry in the list to go to the annotated page.

Removing a Book

When you finish reading a book, you can delete it to conserve
space on your device. If a copy of the book is stored on your
PC, you can download it again at any time.

g To remove a book from your device, tap and hold

the title in the Library list, and then tap Delete on the
pop up menu.

Tap here to change the
color of pen you would
like to draw.
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9.5 @ Pictures

Pictures collects, organizes and sorts .jpg picture files on
your device. You can download images to your PC, and then
use ActiveSync to copy the files to your Pocket PC Phone.
After that, you can view the images as a slide show.

U Pictures can also be stored and transferred to your
device from an MMC, SD or digital camera card.
Insert a card into the memory card slot and then

copy or drag the pictures from your PC to the My
Documents directory on the memory card (If the
memory card does not have a My Documents

directory you must create one first). S
e e
- - L 1|
Transferring Pictures A=
Pictures stored on your PC can be synchronized with Pictures | - _ é@
on your device. Picture synchronization is not automatically [ =
selected in ActiveSync, you need to tap the sync option Files | .. ra ey
in ActiveSync on your desktop PC to activate this function. L -'-:_""_._ e
Finding and listing pictures —e | e
[a} o Tap E — Programs — Pictures.
9 Tap My Pictures and select a folder from the
drop-down menu.
g w |g= A s
ElE Viewing Pictures ol TR
o ‘6’ m BFE . A P i
EQ o> i iew pi i
o o In picture, tap '@' to view pictures as a slide a l -
Q = show. ﬁ'

e Tap i to view pictures stored in your My “ ﬂ l

Picture folder. il B R
© Tap to view pictures stored on a storage :..";"Irﬂ — m
card.
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B Tap anywhere on the screen to display the
u Slide show toolbar, which you can use to
pause the slide show, rotate the view, and

more.

B Press the Left / Right controls to move
forward or backward through the slides.

Sorting Pictures
J
o> o Tap — Programs — Pictures.

o Tap Name and select
an option from the | s -
drop-down menu.

Deleting an Image

[Z) Hold the stylus firmly on the file name of the picture
you want to delete, and then select Delete from the
pop up menu.

j
1

Edit Pictures

You can rotate, crop, zoom and adjust the brightness and
color contrast of your .jpg pictures.

Q2
o> o Tap 4t to rotate a picture 90 degrees counter-
clockwise.

@ Tap H to crop a picture by dragging and
selecting the crop area. Tap outside of the box
to stop cropping.

9 Tap p to display the Zoom panel, from which
you can zoom in or out of a picture, or return a
picture to full-screen size.

o Tap Edit — Brightness and Contrast to adjust
the brightness and contrast levels of a picture.

sweuabouid
uojuedwo)

U Tap Edit — Undo to undo an edit.
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Set Pictures as Background

You can use one of your own .jpg pictures as the background
on the Today screen, and specify how you want it displayed
on the screen, such as adjusting the transparency level.

(3}
o> o In Pictures, tap the picture you want to set as
the background.

o Tap Tools — Set as Today Wallpaper.

u The default setting for the transparency level of the
background picture is 65%. To change the setting,
tap the option Set as Today Wallpaper.

Customizing Pictures

You can opt to launch the Pictures program automatically
when a digital camera storage card is inserted and decide
on a time delay length between slides when showing a slide
show.

a. To select launch automatically:

d
S o Tap E — Programs — Pictures.

9 Tap Tools — Options — then General.

e Then check the box next to Detect digital
camera storage cards.

b. To select the time delay between slides :

(3
> o Tap E — Programs — Pictures.

9 Tap Tools — Options — then Slide Show.

9 Select a number of seconds then tap OK.
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Chapter 10

Using Your Camera
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~10.1-Before:Using:the=—=
—— Camera |
10:2-Camera
10:3-Album——
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10.1 Before Using the Camera

With Camera Wizard, you can use the attached camera on
the back of your device to snap new photos or shoot video
clips with accompanying audio. With Album, it provides many
powerful features to manage, organize, and manipulate the
image, video, and audio files.

When in Image Capture mode, you can capture standard still

images. In Composition Capture mode, you can place your ? 5 [z
captured images into attractive frames (templates). Or, switch ey I -
to Video Capture mode and capture “live” video streams (with ] X !
audio if desired), then share them with others or play them on g e B0

your own Pocket PC phone, desktop PC, or whenever you I
want. You can even send the captured files via E-mail, or
via MMS. Just Snap and Send a newly-captured image, or
Select and Send an existing image.

Of course, you can also get image, video, and audio files
from received E-mail, a Storage Card, infrared beaming, or
synchronized from a PC via ActiveSync, and organize them
into albums and Slide Shows.

File formats supported

File formats that you can browse and view / play in Album
include:

File Type Formats

Still-image formats | BMP

GIF
JPEG
Animation format Animated GIF
Video formats Motion-JPEG AVI (.avi)

MPEG-4 Simple profile (mp4)
3GPP-H.263 baseline (.3gp)

Audio formats MPEG-4 AAC

(Advanced Audio Coding in .mp4 format)
AMR-Narrow Band

(in .mp4 and .3gp format)

WAV

MIDI (standard MIDI type 0,1, and SP-MIDI)
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You can set an audio file to be used as your Pocket
PC phone ’s ring tone. For more information about
ring tone settings, please see Chapter 5.

You can use Camera to capture files in the following formats :

File Type Formats

Still-image formats | BMP
JPEG

Video formats Motion-JPEG AVI (avi)
MPEG-4 Simple profile (mp4)
3GPP-H.263 baseline (.3gp)

Audio formats AMR-NB e 3 -
(Adaptive Multi-Rate Narrow Band) L |
e ks I ah i
@ l‘i:l ";‘r ]
i marn /) i | gl
Hrarder
10.2 Camera B & M [
e e
There are two ways to enter the Camera mode : o .‘1
By by S e ] S e T
[a} o Tap @ — Program — Camera. —i-:

(2] Or just press the lowest button on the left side <
of your device. 7

When you initially enter Camera mode, the Image Capture
submode will be active. The icon at the right side of the LCD
Display area indicates the current submode. After starting —
one, you can easily switch to the other, if desired.

Press to enter the Camera mode

[ | r': Image Capture submode (capture still images)
[ ] [E Video Capture submode (capture video clips )

[ | |E Composite submode (capture stillimages and place
in frame)
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Usage of Buttons in Camera Mode

When in Camera mode, you can press the following buttons on your Pocket PC Phone as a shortcut

to performing various functions.

Orientation toggle

By default, the orientation of the LCD
Display Panel and the incoming video
stream are arranged in a Portrait
display. Press this button to change
to a Landscape orientation.

|

Capture button

Press to launch camera capture
utility. Press again to take a |
picture in still image capture
mode. If in Video Capture
submode, press this button to I
start recording the incoming
video stream, and press it again
to stop the recording process.

Left and Right Buttons

Select template:

If in Composition Capture submode, press to

select the previous or next template.
Select icons:

If in Confirm mode (after capturing

an image or video), press to highlight the
previous or next icon.

Camera Settings screen
Press to toggle the Camera Settings
screen open and closed. If the
screen is open and you have made
changes to the settings, press to
save the settings before closing
the screen.

Capture/Selects
Camera mode - Capture:
Press to capture a still image.
If in Video Capture submode,
press to start recording,

and press again to stop the
recording.

Confirm mode - Selects icons:
Press to confirm the options
you have select.

Up and Down Buttons
Press to Zoom In/Out the incoming
video stream.
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Image Capture submode

When in Image Capture submode, you can capture a single still image by either pressing the Capture
button on your Pocket PC, or by pressing the Action button. This captures the current content shown
on your screen, and saves it to a file immediately using your currently specified flename convention
in Options. You can choose JPEG or BMP as the output format for saved image files, among other
settings in Options.

Components of the LCD Display Panel in Image Capture submode are identified below.

“Las @ Exits Camera
mode and returns
to the previous
Screen.

Incoming video stream is shown
using the entire Pocket PC screen.
(Icons superimposed on the screen
are not saved with your captured
images/videos.)

The Camera Wizard automatically calculates how
many more photos you can capture, according to
your current settings and how much memory you
have left. In this example, 141 more images can
be captured with the current settings and space
available. This counter automatically updates
after you take a picture, or if you change the
Capture Size setting.

Indicates that you
are currently in
Image Capture
submode. Tap to
switch to :

[E Video Capture
Composite

A green icon indicates a camera-
ready state. If red (when in Image
Capture submode), it indicates that

an image capture is currently in Opens the Tap to switch to
progress. Camera Settings | Thumbnail View of
screen. Album mode.

The current Capture Size:
B [ = Large (480x640)
B M = Medium (240x320)
B S = Small (120x160)

The current Zoom setting.
1.0x indicates normal size (see
the Zooming In/Out section).

The current Ambience setting.
In this example, A indicates
that it is set to Automatic (the
default).

Most of the above settings in the LCD Display Panel can be changed using the
” Camera Settings screen. Tap on the Camera Settings icon shown above to display
the Camera Settings screen (illustrated and explained later).
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If the Review file after capture checkbox is currently checked
in the Options — General screen, then immediately after you
capture an image, it will be displayed on the screen along

with four icons.

2
» o To return to the previous screen, tap the Camera

icon.

9 To immediately send a

captured image/video, tap
the mail icon then select

an o

ption from the Send

File dialog box.

o To delete the image press

il g W

10 e o

§F Bl b Meaiea L

the rubbish bin option.

o To view and edit the picture tap the Album icon
(for edit options see Album.)

Zooming I

n/Out

When in Video Capture submode or Image Capture sub-
mode, you can press the Up navigational button on your
Pocket PC to Zoom In the incoming video stream. Each time
you press the “Up” button, the enlargement increases by .2
(1.0, 1.2, 1.4, etc.). When the Zoom limit has been reached
for the current mode/capture size, a beep will sound.

Different maximum limits are available for Zooming, depend-
ing on the current Capture mode, and also depending on the
current Capture Size. The table below summarizes the Zoom
function availability.

Submode Capture Size Setting Zoom Available
Video Large (240 x 320) 1.0x to 2.0x
Capture Medium (144 x 176) | 1.0x to 3.0x

Small (96 x 128) 1.0x to 4.0x
Image Large (480 x 640) 1.0x (no Zoom
Capture available)

Medium (240 x 320) 1.0x to 2.0x

Small (120 x 160) 1.0x to 4.0x
Composition | N/A 1.0x to 2.0x
Capture

Confirm mode screen:

Remarks

1x = normal size (no Zoom)
2x = double enlargement
3x = triple enlargement

4x = quadruple enlargement
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Video Capture submode
To start video recording :
Q} o Tap the Camera or composite icons until the video capture icon appears.

o Press the Capture button on the left side of your Pocket PC, or the Action
button.

e To stop recording, press it again. The first frame of the newly-captured video file will
be displayed, and the four icons (shown and explained earlier) will be available.

Video capture output format: Motion-JPEG AVI file format, or H.263, or MPEG4, depending on
what you specify in the Video tab of Options. Components of the LCD Display Panel in Video
Capture submode are identified below.

Incoming video stream is shown
using the entire Pocket PC screen.

Exits Camera
mode and returns
to the previous
The Camera Wizard calculates how much time Screen.
is still available for capturing more video clips,
according to your current settings and how
much memory you have left. In this example,
7 minutes and 8 seconds are available for
new video capture. This counter automatically
updates after you capture a video, or if you
change the Capture Size setting.

Indicates that you
are currently in
Video Capture
submode. Tap to
switch to :

Camera mode

“ When video capture is in progress, this

indicator functions as a time counter — .

which displays the number of minutes/ Composite

seconds that have elapsed during the

current recording

Opens the Tap to switch to
A green icon indicates a camera- Camera Settings Thumbnail View of
ready state. If red (when in Video screen. Album mode.
Capture submode), it indicates
that video recording is currently in The current Zoom setting. In this
progress. example, the display has been
enlarged to 2.6 times the normal

The current Capture Size: Size.

[ = Large 240x320
B M = Medium 144x176
B S =Small 96 x128

0
Q
3
2
Q

The current Ambience setting. In this example,
the icon indicates that it is set to Daylight.

InoA Buisn
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Composition Capture submode

The Composition submode lets you choose a template in which you can place one or more images.
You can think of a template as a type of frame in which you would insert a photograph. A few
templates are already included with your Camera Wizard, in the subfolder named \My Documents\
Templates. You can download additional templates for free from http://www.iastyle.com.

Components of the LCD Display Panel in Composition Capture submode are identified below.

This particular template happens

TRELE hom . w g IO ﬁ'— Exits Camera
to require two captured images. In "B 8 B Ooh E e

mode and returns

this example, “1/ 2” indicates that ] lI:i",'lI to the previous
the next capture will be Capture #1 :;'J pi screen.
and will fill the first Place Holder M =
that currently has the focus. .-:E ®
1 < B
. . L L [ Indicates that
The Camera Wizard automatically calculates r 5 you are currently
how many more photos you can capture, ] == in Composition
according to your current settings gnd how ¥ v t:: Capture submode.
much memory you have left. In this example, ™ W Tap to switch to :
494 more images can be captured with the {] . -
current settings and space available. . Camera mode
b -
A green icon indicates a camera- ‘?‘?-?'?‘EEE@— [a Video Capture
ready state. If red, it indicates that
an image capture is currently in
progress. Opens the Tap to switch to
Camera Settings Thumbnail View of
The current Ambience setting. screen. Alburm mode.
In this example, the icon
indicates that it is currently set to 1.0x indicates normal size. In Composition mode,
Incandescent. you can zoom to a maximum of 2.0x. Press the Up

button on your Pocket PC to Zoom In.

’ Most of the above settings in the LCD Display Panel can be changed using the Quick
U Camera Settings screen. Tap on the Quick Camera Settings icon shown above to
display the Quick Camera Settings screen (illustrated and explained later).

5
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To change the template:

[a} o Enter Composition Capture submode. " — T diiii £
9 Press the Right navigational button on your -
Pocket PC to load the next sequential template, L Sl == -
or the Left button to display the previous. L -
© o, tap the Camera Settings icon in the LCD Tor == =
Display Panel to display the Camera Settings bl ) '9
screen. _E

o The Template field is available in the screen only

when the screen is opened from Composition |-||..; : J
Capture mode. You can select the desired —
template from the drop-down list in the Template haed o

field.

6 You can tap the Browse
button to view the
detailed information of

the template name along _.-.LI.:::..
with the resolution in j:'--:.éu"
pixels, and the number of j::‘:‘
pictures needed to fill that e
template. T ) il

e E B i '

o To change the folders | ™ == "=t

§ L i | el I
so that you can access —_= _-"".'-
templates from a different | === =
folder, tap the Change.. B

button.

B |f the chosen template requires more than
U one captured image, the incoming video
stream will be visible in only one of the Place
Holders. The first captured image will be put
into the active Place Holder. The focus will
then switch to another Place Holder in the
template. Likewise, the next captured image
will then be placed into that Place Holder.

m |If, for example, the template requires two
captured images, the LCD Display Panel will
display "1/2" initially. After capturing the first
image, the LCD Display Panel will display
"2/2" to indicate that the next captured image
will be the second only.

0
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Camera Settings screen

When in any of the capture submodes (Image, Video, or m
Composition), you can tap [E to display the Camera Set- — ===
tings screen. Or, you can press the upper right button on S e ]
the front of your Pocket PC . — i "
U The Template drop-down list and the Browse... - ===

button are available in the Camera Settings S |

screen only when Composition is selected in

the Capture mode field. |__|_ J
Icons on the menu bar s

[1; o Access the Help Messages for Camera Wizard 6 é ]6

and automatically displays an illustration of the
usage of the buttons on your Pocket PC.

e Switches to the Thumbnail View of Album
mode.

9 Switches to the Detailed View of Album mode.

Settings Explanation

Capture Mode Select the mode - Image, Video, or Composition - you want to create
settings for.

Capture Size The choices for Capture Size will be different, depending on whether
you are in Image Capture submode or Video Capture submode. Higher
Capture Size settings produce larger file sizes.

Ambience Open a drop-down list that lets you easily adjust the Capture screen to
look its best in various environments.

If you select Effects in the Ambience field, an additional drop-down list
of options is available. These options also affect the appearance of the
incoming video stream :

B Grayscale (black and white)

B Sepia (reddish tint)

B Cool (bluish tint)

B Negative (darkness and lightness reversed)

©
R
Q
£
]
o

After you have adjusted the settings as described below, you
can either tap the OK button or the Start Camera button to
return to the previous (capture) mode.

.
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Tools Menu

The Tools Menu provides many more settings that let you
customize the behavior of Camera mode functions.

a) Adjust...

[2} o Tap Tools and then Adjust... below. In the drop-
down list of the Property field, you can select
Contrast, Saturation, Brightness, Gamma or
Sharpness.

o Use the Slider Bar to adjust the value.
U The incoming video stream displayed on your

screen will immediately show the effect of any
changes you make.

e Select Reset if you wish to reset all properties
to their original default values. Tap OK to save
changes and return to the Camera Settings
screen.

b) Options...

The Options screen contains three tabs: General, Image,
and Video.

- General tab

The General tab is shown below. These options are mostly m

self-explanatory. However, note that Flicker Adjustment |—_""'""'—' —
refers to the electrical voltage used in your country. Il i s et

o e i m maiam

e
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- Image tab

These options affect only your still im- [P I [T

age captures. vt || |t P «
e A — e | B E B~ S—
e T T -] e L -

wrve e ] | St it | arre - ._:|l-l—|-|
- — e

¥ il i | | o
A i par ey

[ memag, v

=

S ) e

L3 o

Options Function

Prefix Type and | By default, the filename of each new captured image file will be image
Prefix String followed by a sequential number, for example: image_00001.jpg. If
you wish to change this prefix to a different arbitrary text string, select
String in the Prefix Type field and type the desired characters into the
Prefix String field. For example, entering “party” in the Prefix String
field would produce the filename party_00001.jpg.

Alternatively, you can choose Date or Date and Time as the Prefix
Type.

Capture Format | You can choose for your captured still images to be saved in either the
JPEG file format or the BMP file format.

Counter Index By default, sequential numbers are automatically incorporated into
each filename for all new image files you capture, such as 00000,
00001, 00002, etc. The number follows the Prefix (explained above).
To reset the numbering to “00000” for your captured image files, tap
Reset counter.

Folder By default, your captured image files will be saved to your \My
Documents\My Pictures folder. The current Save folder is displayed
in the Image tab. If you wish to change the Save folder, tap the
Change... button. Select the desired folder, then tap OK.

5
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- Video tab

The options on the Video tab affect only your captured
video files.

Options Function

Prefix Type and | By default, the filename of each new captured video file will be “video”
Prefix String followed by a sequential number, for example: video_00001.avi.

If you wish to change this prefix to a different arbitrary text string,
select String in the Prefix Type field and type the desired characters
into the Prefix String field. For example, entering “vacation” in the
Prefix String field would produce the filename vacation_00001.jpg.
Alternatively, you can choose Date or Date and Time as the Prefix
Type.

Format You can choose for your captured video clips to be saved in either the
Motion-JPEG AVI, H.263 (3GP), or MPEG4 file formats.

Counter Index By default, sequential numbers are automatically incorporated into
each filename for all new video files you capture, such as 00000,
00001, 00002, etc. The number follows the Prefix (explained above).
To reset the numbering to “00000” for your captured video files, tap
Reset counter.

Recording If you wish to limit video captures so that the capture automatically
Limitation of stops when a certain file size is reached, select the Limited to
Video Size Kilobytes button, then enter the desired number in the text box.

If you don’t want to limit the file size, select the Limited by available
storage space button (the default). This means video capture will
continue until your available storage space is all consumed.

Recording with | When this checkbox is checked, audio will be recorded with your

Audio captured video clips. It is checked by default. Any videos captured
when the checkbox is not checked would be silent (no accompanying
audio).

Folder By default, your captured video files will be saved to your \My

Documents folder. The current “Save” folder is displayed in the Video
tab. If you wish to change the “Save” folder, tap the Change... button.
A “tree view” of your existing folders will be displayed. Select the
desired folder, then tap OK.
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10.3 &/Album

Select the Album icon in your Pocket PC Phone Edition’s
Programs group to view image and video files, and to play
audio files. Three view modes are available: Thumbnail
view, Detailed view, and Slide Show view.

To enter Album mode,
Q3
= o Tap

9 Or, tap the Album icon in Camera mode.

— Program — then tap IEJ

Thumbnail View Mode

The first time you enter Album mode, Camera Wizard’s
Thumbnail View mode will be invoked. By default, your \My
Documents\My Pictures folder will be searched initially.
U B You can manually change the position of a
thumbnail simply by pressing your stylus on it
and then dragging it to the desired location.

B To select multiple thumbnails, press your stylus
in an empty part of the screen, then drag your
stylus across all thumbnails you want to include
in the multi-selection.

D“

o Current folder is shown here. Tap this field if you

want to search a different folder.
9 Tap to select a different thumbnail P
. Sradl
size.
w Ty
Ll

To change the way the thumbnails are sorted,

tap here.
Sy
This speaker icon indicates | Balr
that audio annotation has been | Typ
recorded and associated with | =
Hrvrerse

this file.

Py b
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R EE =R
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© Tap to switch to Camera mode. List View:
@ Tap to switch to Slide Show view. T - 48
U o ey -
AN T -
0 Tap to switch to Detailed view. (Or, tap directly S "o
on a thumbnail to load that file into Detailed B =
View.) If an audio or video file, it will begin T -
playing. e e
=l
@ A etter icon in lower left corner of thumbnail B, et
indicates various meanings: g, ETLE o
A - indicates that text annotation has been ol i
associated with this file. s T 3 B .-
G - indicates an animated GIF file.
Lo . . X The pop up menu when you tap and
V - indicates that it is a video file. hold on a thumbnail.

U B To open a convenient pop-up menu that m
contains frequently used commands, press A M
your stylus on the thumbnail you want to

operate on.

B To see a still image full-screen, or to play a
video or audio file, tap the desired thumbnail

To make an annotation on your
file:

This command lets you add (or remove) text or audio annota-

tion for a file. The associated text and/or audio recording can m

then be set to display/play during a Slide Show. P ——
‘G @ Inthe Thumbnail View mode screen, Select TN
the desired file — then select the Annotate...

command from Edit menu.

U B After text annotation has been added, an
icon will be shown in the thumbnail. A separate
text file will be created for that text.

B After audio annotation has been added, an
<l icon will be shown in the thumbnail. A
separate audio file, in the WAV file format, will
be created.

[
0o
Q3
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o
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e If you wish to associate text with the file, enter
it in the text box.

o To create an audio recording (either voice
or music) as an annotation using your built-
in Pocket PC microphone,tap @to begin
recording, tap |E| to stop recording.

u If an audio recording already exists and you

then tap the Record button, there is no warning

confirmation. Your previous recording will be

instantly lost and overwritten by the new recording.

If you have tapped Remove Voice by accident,

simply tap Cancel (this cancels the removal
operation so that the audio is retrieved).

Sending MMS, E-mail in Album

ré} @ Firstselect the desired file — tap Tools — then
select an option from the menu.

9 Follow the relevant procedures for sending that
type of message.

u In addition, if you have an MMS client, the menu
will contain the Send via MMS command.

To set audio files as Ring Tones:

Simply select the desired file, then select Set as Ring Tone
from the Tools Menu (or the menu that pops up when you

£ mamyeyie
tap-and-hold on a thumbnail). The previous ring tone will be o B :':":: ,m:-_-'""'w
immediately replaced. A message will display the filename i o

and confirm that the operation was successful. Tngem
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Assign to Contact

This command allows you to assign an image as a Photo ID
to a Contact entry in your Pocket Contacts.

rﬁ} o Choose the image you want to use as a Photo
ID.

9 Select Assign to Contact. The Photo Contacts
application will be invoked. The Contact entries
in your Pocket Contacts will be displayed.

o Select the Contact entry to which you want to
assign the Photo ID, and assign the desired
attributes as you normally would in Photo
Contacts (Photo only, or photo with template,
etc.).

o The Photo Contacts Preview screen will show
you a preview of how the Photo ID setup looks.

After you save it, Photo Contacts will exit, and m

you will automatically be returned to Camera e N " |
Wizard. e |
T 4|
- - - Frem bemn ey
Options in Album Settings 8 st
Q} To change the settings when using Album, tap T v
Options from the Tools menu. Two tabs are -
comprised: General and Slide Show.
vt |
-

- General tab

Function Explanation

Default zoom The setting in the Default Zoom field controls the size of the selected
file when it is initially displayed in Detailed View. If set to Smart, the
Camera Wizard will automatically calculate the best size in which to
display the file on the screen. However, if you want files to always
be initially displayed in their original size, select Original Size from
the drop-down list box. If you want Camera Wizard to automatically
display selected files so that they fit within the screen, select Fit In
Window.
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Function Explanation

Auto rotate If None is selected, no automatic rotation will take place when a file

is displayed in Detailed View (but you can still rotate the display
manually using the Rotate Clockwise and Rotate Counterclockwise
icons on the Toolbar in Detailed View). Select Left to automatically
rotate images 90 degrees to the left in Detailed View, or Right if you
want rotation to occur 90 degrees to the right.

Animation speed | The setting in the Animation Speed field controls the speed at which
animated GIF files will be played. By default, this is set to Normal.
You can select Faster, Slower, or No Delay from the drop-down list.

Keep backlight | If you have set your Backlight to dim after a certain number of seconds,
on while playing | you can override it by checking this checkbox. This ensures that the
video Backlight will not dim during your video playbacks.

Adjust Gamma The Adjust Gamma setting controls image brightness/darkness.

The minimum setting of 0.01 will cause images to display very dark.
The maximum setting of 3.00 will cause them to display very light
(“wash out”). If you change this setting, you can conveniently reset it to
1.00 by tapping the Reset button. This feature assists you in viewing
an image more easily under different lighting conditions.

Slide Show tab
These settings control only the behavior of Slide Show view m

mode. These options are mostly self-explanatory, just choose Ju— ==

the item you need and follow the relevant procedures for the Bebenbe [ 18] w—

way you want the Slide Show to work. |
R

Flaasrsms |1
[Tl s m]

[ (e

[ e ks 1w i

b B by e e

ey VR |
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Detailed View Mode

Detailed View mode displays the selected file in an enlarged
view, and you can further manipulate the view in various ways
(zoom, rotate, pan, etc.).

[a) o Toolbar
9 Command Bar
o Hide or display the Toolbar.
o Switch to Thumbnail view.
e Switch to Slide Show view.

0 Switch to Camera mode.

Icons on the Toolbar

l Previous file ‘ l Next file ‘ Rotate Rotate Counterclockwise

\ J Clockwise (90 degrees each time tapped)
\ / Toggles the Quick

e R 54 ':? f—ﬂ\m B P view window open

and closed

Zoom | | Zoom Fit to Actual size (1:1
Out In window | | pixel ratio)

Images too big for screen

rﬁ) o Whenever the image is too large to be shown
in the display area in its entirety, you can simply
press your stylus anywhere in the display area
and drag, to interactively quick-pan the image
to any desired position.

e Alternatively, you can open the Quick View
window as shown on the right, by tapping the
Quick View icon on the Toolbar. The dotted
outline within the Quick View window shows
the currently displayed portion, in relation to
the entire image. Drag the outline within the
Quick View window to the desired position, or
tap within the Quick View window to jump the
outline to a different position. When satisfied
with the position, tap the Quick View icon again
to close the Quick View window.
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To set as Today Wallpaper:

This command allows you to change the background image
of the Today screen on your Pocket PC to any image you
want.

ré} o In Album, tap to open a video file or image you
want to use as the image for the wallpaper.

e If desired, you can manipulate it in any way
you wish: Zoom In or Out, Rotate, Pan, etc.
The exact state of the image as displayed on
your screen will be used as the Today screen
image.

U Likewise, if you have chosen a video file and do
not wish to use the first frame of the video as the
wallpaper, you can start playing the video and
then open the Tools Menu at the frame you want
to use. (The video is paused when the menu is

open.)

o Select Set as Today Wallpaper. The message
“The Today screen background image has
been successfully changed” will display.

To Reset the Today Screen back to the (v 37 4w €

Default Wallpaper: .
T

If you later decide that you want to re-set the Today screen (L]

back to the original default background,

J

o> Tap [#5 — Settings — Today icon in the Personal

tab — Select Windows Default in the list — then
make sure the Use this picture as the background p
checkbox is checked — Tap OK. :
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Slide Show View

When in Thumbnail View or Detailed View, you can tap the icon in the Command Bar to enter
Slide Show mode.

In Slide Show mode, allimage, video, and audio files will automatically be displayed/played, one
after another. If video and audio files are encountered during a Slide Show, they will be played
once, and then the next file in the Slide Show will be displayed/played. However, you can play
it over again manually if desired.

Tapping anywhere on the screen will momentarily display the Toolbar.

You can choose to display
your annotated text during a
Slide Show, or the filename,
or no text at all. You can
also change font color, size,
position, etc., as we have
done in this example.

Tap to re-display the previous
file. Tap repeatedly to quickly
Rewind to the desired file.
(The three leftmost icons

become available after Stop Exits Slide Show
has been tapped.) mode and enters
Detailed View
Tap once (or mode.
repeatedly) to Fast
Forwarq to 'the next Exits Slide Show mode
sequential files. and enters Thumbnail
View mode

Tap to resume playing a Stops playback and
Slide Show that has been stays on the current
stopped. slide, but does not

exit Slide Show mode
(pseudo-pause).

Slide Show Properties. Lets you set
Transition Effects, Rotation, Text
display, Audio, Delay Time between
slides (for image files), Random or
forward-sequential display, etc. in the
Slide Show Options screen..
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Maintaining Your Pocket PC
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Adding or Removing Programs

Programs added to your device at the factory by default are m:

stored in ROM (read only memory). You cannot remove them, s U E e
and you will never accidentally lose them. You can install _'

any other programs created for your device, as long as your g S : -
device has enough memory. The most popular place to find e
software for your device is on the Pocket PC Web site http: . = o i | |

//www.microsoft.com/mobile/pocketpc.

To add programs using ActiveSync :

You will need to install the appropriate software for your device
on your PC before installing it on your device.

Appendix A
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[—& o Download the program to your PC (or insert the
CD or disk that contains the program into your
PC). Be sure to select the program designed
for the Pocket PC and your device process or
type.
e Read any installation instructions, or
documentation that comes with the program.
Many programs provide special installation
instructions.

Connect your device and PC.
Double click the .exe file.

= 00

u If the file is an installer, the installation wizard

will begin. Follow the directions on the screen.
Once the software has been installed on your
PC, the installer will automatically transfer the
software to your device.

B [f the file is not an installer, you will see an
error message stating that the program is
valid but it is designed for a different type of
PC. You will need to move this file to your
device. If you cannot find any installation
instructions for the program in the Read Me file
or documentation, use ActiveSync Explore
to copy the program file to the Program Files
folder on your device.

Once installation is complete, tap E — Programs —
and then its program icon.
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To add a program directly from the
Internet:

[—“ o Determine your device and processor type so —
that you know which version of the software to el
install. ﬂ ety = |
9 Download the program to your device directly :I i L
from the Internet using Pocket Internet e = 2>
Explorer. You may see a single *.xip, *.exe or RS = E
*.zip file, a setup.exe file, or several versions of _| eIl gr g
files for different device types and processors. T 52
Be sure to select the program designed for the i 1~ — = 5 X
Pocket PC and your device processor type. R Ol a »
— = sdas  m-

o Read any installation instructions, Read Me files,
or documentation that comes with the program.
Many programs provide special installation
instructions.

o Tap the file, such as a *.xip or *.exe file.
The installation wizard will begin. Follow the
directions on the screen.

To remove a program : e st O

r;} Tap E — Settings — System — Remove e
Programs. @ IB ‘ a
[-*1Y Baran —amary
B el
u B You can only remove programs that you ,!, # Ty
installed in storage memory. Programs that 5 Sl a

came with your device cannot be removed.

B You can quickly return your device to the
factory default configuration by clearing all
memory. All data will be lost. For instructions,
see the details later in this chapter.
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Managing Memory

Memory on your Pocket PC Phone is shared between storage
memory and program memory. Storage memory is used to
store the information you created and programs you installed.
Program memory is used to run programs on your Pocket PC
Phone. Pocket PC Phone automatically manages the allo-
cation between storage and program memory.

To view memory allocation and
availability :

fa}

Tap E — Settings — System tab — and then tap
Memory icon.

Finding Space in Storage memory

In some situations, such as when memory is low, your Pocket
PC Phone may not be able to automatically adjust the alloca-
tion. If you receive a message stating that storage or program
memory is unavailable, try the following solution :

a. Move data to a SD storage card
S

o Tap m Programs — and then File Explorer.

e Tap and hold the file you want to move, and
tap Cut. Open the My Documents folder in
the storage card folder, tap Edit, and then tap
Paste.

Files stored in folders other than My Documents or stored
in folders within sub-folders in My Documents may not show
up in the list view of some programs. When using Notes,
Pocket Word, or Pocket Excel, you can also move files
by opening the item and tapping Tools or Edit and then
Rename/Move.
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b. Move e-mail attachments

J
> o On Inbox — tap Tools — and then Options.

e On the Storage tab, select Store attachments
on storage card then tap OK. All existing
attachments are moved to the storage card,
and new attachments are automatically stored
on the storage card.

c. Save new items on the storage card

Set programs such as Notes, Pocket Word, and Pocket
Excel to automatically save new items on the storage card.

d
o> o In the program — tap Tools — and then
Options.

e In the Save to field select Storage Card.

d. Delete unnecessary files
[a} o Tap ﬁ — Programs — and then File Explorer.

9 Tap and hold the file, and then tap Delete on the
pop up menu.

To find your largest files, tap E and then Find.
In the Type list, tap Larger than 64 KB, and then
tap Go.

(U

e. Delete all files and clear history in
Internet Explore

[2‘} In Internet Explorer, tap Tools and then Options. Tap
Delete Files and Clear History.
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Backing Up Files

Because any new programs or data are stored in RAM, and
therefore will be lost if your device loses power for any reason,
it is critical that you backup files to your computer, ora mem-
ory card. When you are at your desktop you can synchronize
with your computer to backup files, however, if you are going
outside and unable to access your desktop, you will need to
backup files to an SD or MMC card. Your device enables you
to backup individual files in Word or Excel or all files in SD
backup. Further more, you can also backup and then restore
Contacts, Calendar, Internet and E-mail Settings.

SD and MMC Cards

Your device has an expansion slot compatible with a range
of SD and MMC Memory cards, which are primarily used to
backup or transfer files and data.

To insert or remove a memory card:

f‘ o Push the memory card into slot until it clicks into
place. The card is secure when it is not protruding
from the base.

0 To remove the card push it in and then release,
letting the card spring out.

When you receive your device there will be a piece of plastic
in the slot; remove as described in "2" above.

To save Word or Excel files to a
memory card :

(2]
o o Push the memory card into the slot until it
clicks into place. The card is secure when it is

not protruding from the base.

e In application programs (e.g. Pocket Word or
Excel), press Tools — Options.

9 Tap the drop down menu box under Save To and
select Storage Card.
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Backup or restore your system
using xBackup :

(3}
o o Tap E — Programs — xBackup — then the m

Backup or Restore tab. =l
.:I .h'-J l - -\.-..ﬂn.'tn. dn:a-l.i.-ﬂ..
e If you have inserted the SD card properly it will e
appear next to Target by tapping Open and -
LD &0 AL T O
select Storage Card under the task bar. vt Bt

e el W L TR
b s Brsbaklis IRAD AR

o Make sure there are no application programs
running, then tap Start.
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Backup or restore your system via
ActiveSync

(3]
> o Double click the icon of ActiveSync l[a in
the task bar of your PC.

o Select Backup/Restore option in the drop-
down menu of Tool in ActiveSync.

9 Select the Backup tap to backup your
system; if necessary; Select the Restore
tab to restore your system if necessary.

Reset the Pocket PC Phone and
Clear Memory

You can perform a soft reset or a full reset. During a soft
reset, the device is restarted and only some data in open
programs may be lost. However, a full reset turns the battery
off and returns the device to its original factory settings and
deletes all programs, files, contacts and other information you
have saved to the device. Therefore it is extremely important
to backup data to a storage card or your computer on a regular
basis in the event that a full reset has to be performed.
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To perform a soft reset :

If your Pocket PC Phone responds slowly stops responding or
freezes, try a soft reset. A soft reset causes the Pocket PC
Phone to restart and re-adjust memory allocation. Unsaved
data in open windows may be lost.

(pa)
S Usethe stylus to press and hold the Reset button.

To perform a full reset :

Afull device reset clears memory, deletes all data and restores
the Pocket PC Phone to its default settings. Programs installed
at the factory remain, while data you have created and pro-
grams you have installed are all erased.

Jd
& Press and hold the power button, and then use stylus
to press the soft reset button at he same time.

u Be sure you have backup all your data in a SD card
or in your PC before performing a full reset.

Press and
hold the power
button.
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Regulatory Agency
Identification Numbers

For regulatory identification purposes your product
is assigned a model number PH10x.

The following accessories have been approved for
use with your device. Their assigned model numbers
listed below can identify these approved accessories.
To ensure continued reliable and safe operation of
your Pocket PC Phone, use only the accessories
listed below with your PH10x.

Accessories Model Number

Cradle PH15x
CF Back Pack PH16x
Battery Pack PH17x

=y " The above X may be any
alphanumeric character or blank
denoting external cosmetic
changes.

B This product is intended for use
with certified Class 2 Limited Power
Source, rated 5 VDC, minimum 2A
power supply unit.

European Union Notice

Products with CE marking comply with the R&TTE
Directive (99/5/EC), the EMC Directive (89/336/
EEC) and the Low Voltage Directive (73/23/EEC)
issued by the Commission of the European
Community.

Compliance with these directives implies conformity
to the following European Norms (in brackets are
the equivalent international standards):

B EN 60950 (IEC 60950)
Safety of InformationTechnology Equipment.

ETSI EN 301 511

Global system for mobile communications
(GSM); Harmonized EN for mobile stations in
the GSM 900 and GSM 1800 bands covering
essential requirements of article 3.2 of the
R&TTE directive (1995/5/EC )

ETSI EN 301 489-1

Electromagnetic compatibility and Radio
spectrum Matters (ERM); ElectroMagnetic
Compatibility (EMC) standard for radio
equipment and services; Part 1: Common
technical requirements

ETSI EN 301 489-7

Electromagnetic compatibility and Radio
spectrum Matters (ERM); ElectroMagnetic
Compatibility (EMC) standard for radio
equipment and services; Part 7: Specific
conditions for mobile and protable radio
and ancillary equipment of digital cellular
radio telecommunications systems (GSM
and DCS)

ETSI EN 301 489-17

Electromagnetic compatibility and Radio
spectrum Matters (ERM); ElectroMagnetic
Compatibility (EMC) standard for radio
equipment and services; Part 17: Specific
conditions for 2.4 GHz wideband transmission
systems and 5 GHz high performance RLAN
equipment.

ETSI EN 300 328

Electromagnetic compatibility and Radio
spectrum Matters (ERM); Wideband
Transmission systems; data transmission
equipment operating in the 2.4 GHz ISM
band and using spread spectrum modulation
techniques.

GSM11.10

ANSV/IEEE C.95.1-1992
Specific absorption rate in mobile phone
emission condition for body health

EN50360, EN50361 for SAR
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FCC Compliance
Statement

B FCC part 15 and part 24

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions : (!) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

H FCC ID : NM8 HIMALAYAS

B Statement according to FCC part 15.105

NOTE : This equipment has been tested and found
to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection
against harmful interference in a residential
installation. This equipment generates, uses
and can radiate radio frequency energy and, if
not installed and used in accordance with the
instructions, may cause harmful interference
to radio communications. However, there is no
guarantee that interference will not occur in a
particular installation. If this equipment does
cause harmful interference to radio or television
reception, which can be determined by turning the
equipment off and on, the user is encouraged to
try to correct the interference by one or more of
the following measures .

B Reorient or relocate the receiving
antenna.

B Increase the separation between the
equipment and receiver.

B Consult the dealer or an experienced radio/
TV technician for help.

B Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

RF exposures

Tests for SAR are conducted using standard
operating positions specified by the FCC with the
phone transmitting at its highest certified power
level in all tested frequency bands. Although the
SAR is determined at the highest certified power
level, the actual SAR level of the phone while
operation can be well below the maximum value.
This is because the phone is designed to operate
at multiple power levels so as to use only the
power required to reach the network. In general,
the closer you are to a wireless base station
antenna, the lower the power output.

Before a phone model is available for sale to the
public, it must be tested and certified to the FCC
that it does not exceed the limit established by
the government-adopted requirement for safe
exposure. The tests are performed in positions and
locations (e.g., at the ear and worn on the body) as
required by the FCC for each model. (Body-worn
measurements may differ among phone models,
depending upon available accessories and FCC
requirements). While there may be differences
between the SAR levels of various phones and at
various positions, they all meet the government
requirement for safe exposure.

For body worn operation, to maintain compliance
with FCC RF exposure guidelines, use only High
Tech computer, Corp. approved accessories.
When carrying the phone while it is on, use the
specific High Tech computer, Corp. supplied or
approved carrying case, holster, or other body-
worn accessory.

Use of non High Tech computer, Corp. approved
accessories may violate FCC RF exposure
guidelines and should be avoided.
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Important Health and
Safety Information

Retain and follow all product safety and operating
instructions. Observe all warn and in the operating
instructions on the product

To reduce the risk of bodily injury, electric shock,
fire, and damage to the equipment observe the
following precautions.

a) General Precautions

B Heed service markings
Except as explained elsewhere in the
Operating or Service documentation, do not
service any product yourself. Service needed
on components inside these compartments
should be done by an authorized service
technicians or provider.

B Damage requiring service

Unplug the product from the electrical outlet

and refer servicing to an authorized service

technicians or provider under the following

conditions:

® Liquid has been spilled or an object has
fallen into the product.

® The product has been exposed to rain or
water.

® The product has been dropped or dama-
ged.

® There are noticeable signs of overheat-
ing.

® The product does not operate normally
when you follow the operating
instructions.

B Avoid hot areas
The product should be placed away from heat
sources such as radiators, heat registers,
stoves, or other products (including amplifiers)
that produce heat.

B Avoid wet areas
Never use the product in a wet location.

Avoid pushing objects into product

Never push objects of any kind into cabinet
slots or other openings in the product. Slots
and openings are provided for ventilation.
These openings must not be blocked or
covered.

Mounting Accessories

Do not use the product on an unstable
table, cart, stand, tripod, or bracket. Any
mounting of the product should follow the
manufacturer's instructions, and should use
a mounting accessory recommended by the
manufacturer.

Avoid unstable mounting
Do not place the product with an unstable
base.

Use product with approved equipment
This product should be used only with personal
computers and options identified as suitable
for use with your equipment.

Adjust the volume

Turn down the volume before using
headphones or other audio devices.
Cleaning

Unplug the product from the wall outlet before
cleaning. Do not use liquid cleaners or aerosol
cleaners. Use a damp cloth for cleaning, but
NEVER use water to clean the LCD screen.

b) Safety Precautions for

Power Supply Unit

B Use the correct external power source

A product should be operated only from
the type of power source indicated on the
electrical ratings label. If you are not sure of
the type of power source required, consult your
authorized service provider or local power
company. For a product that operates from
battery power or other sources, refer to the
operating instructions that are included with
the product
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B Handle battery packs carefully

This product contains a Li-ion Polymer battery.
There is a risk of fire and burns if the battery
pack is handled improperly. Do not attempt to
open or service the battery pack.

Do not disassemble, crush, puncture, short
external contacts or circuits, dispose of in
fire or water, or expose a battery pack to
temperatures higher than 60¢XC (140¢XF).

54
2

Li-ion

Warning: DANGER OF EXPLOSION
IF BATTERY IS INCORRECTLY
RE-PLACED. TO REDUCE RISK
OF FIRE OR BURNS, DO NOT
DISASSEMBLE, CRUSH, PUNCTURE,
SHORT EXTERNAL CONTACTS,
HEAT ABOVE 100 (212 ), OR
DISPOSE OF IN FIRE OR WATER.
REPLACE ONLY WITH SPECIFIED
BATTERIES. RECYCLE OR DISPOSE
OF USED BATTERIES ACCORDING
TO THE LOCAL RE-GULATIONS
OR REFERENCE GUIDE SUPPLIED
WITH YOUR PRODUCT.

c) Exposure to Radio
Frequency (RF) Signals

Your wireless phone is a radio transmitter and
receiver. It is designed and manufactured not
to exceed the emission limits for exposure
to radio frequency (RF) energy set by the
Federal Communications Commission of the
U.S. Government. These limits are part of
comprehensive guidelines and establish permitted
levels of RF energy for the general population.
The guidelines are based on the safety standards
previously set by both U.S. and international
standards bodies:
B American National Standards Institute
(ANSI) IEEE. C95.1-1992
B National Council on Radiation Protection
and Measurement (NCRP). Report 86. 1986

B International Commission on Non-lonizing
Radiation Protection (ICNIRP) 1996

B Ministry of Health (Canada), Safety Code
6. The standards include a substantial safety
margin designed to assure the safety of all
persons, regardless of age and health.

The exposure standard for wireless mobile
phones employs a unit of measurement known
as the Specific Absorption Rate, or SAR. The
SAR limit set by the FCC is 1.6W/kg *.

*In the U.S. and Canada, the SAR limit for mobile
phones used by the public is 1.6 watts/kg (W/kg)
averaged over one gram of tissue. The standard
incorporates a substantial margin of safety to give
additional protection for the public and to account
for any variations in.

d) SAR Information

B SAR:0.271 W/kg @10g (Europe),
0.612 W/kg @10g (Australia),
0.468 W/kg @19 (Taiwan),
0.726 W/kg @1g (USA)

THIS MODEL DEVICE MEETS THE GOVERN-
MENT'S REQUIREMENTS FOR EXPOSURE TO
RADIO WAVES.

Your wireless mobile GSM phone is a radio
transmitter and receiver. It is designed and
manufactured not to exceed the emission limits
for exposure to radio frequency (RF) energy set
by the Federal Communications Commission of
the U.S. Government. These limits are part of
comprehensive guidelines and establish permitted
levels of RF energy for the general population.
The guidelines are based on the safety standards
previously set by both U.S. and international
standards bodies :
B American National Standards Institute
(ANSI) IEEE. C95.1-1992
B National Council on Radiation Protection
and Measurement (NCRP). Report 86. 1986
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B International Commission on Non-
lonizing Radiation Protection (ICNIRP) 1996

B Ministry of Health (Canada), Safety
Code 6. The standards include a substantial
safety margin designed to assure the safety
of all persons, regardless of age and health.

The exposure standard for wireless mobile GSM
phone employs a unit of measurement known as
the Specific Absorption Rate, or SAR. The SAR
limit set by the FCC is 1.6W/kg*.

For body worn operation, this phone has been
tested and meets the FCC RF exposure guidelines
when used with an accessory that contains
no metal and that position the antenna of the
GSM phone a minimum of 1.5cm from the body.
The SAR values of this GSM phone are 0.726
Wi/g (body) and 0.362 W/g (head). Use of other
accessories may not ensure compliance with the
FCC RF exposure guidelines.

The FCC has granted an Equipment Authorization
for this model device with all reported SAR levels
evaluated as in compliance with the FCC RF
exposure guidelines. SAR information on this
model device is on file with the FCC and can be
found under the Display Grant section of hitp:
//www.fcc.gov/oet/fccid after searching on FCC
ID: NM8 HIMALAYAS. Additional information
on Specific Absorption Rates (SAR) can be
found on the Cellular Telecommunications &
Internet Association (CTIA) web-site as hitp:
//www.devicefacts.net.

*Inthe U.S. and Canada, the SAR limit for mobile
GSM phone used by the public is 1.6Watts/kg
(W/kg) averaged over one gram of tissue. The
standard incorporates a substantial margin of
safety to give additional protection for the public
and to account for any variations in.

e) Important Safety
Precautions

When using this product, the safety precautions
below must be taken against possible legal issues
and damages.

B ELECTRICAL SAFETY

This product is intended for use when supplied with
power from the battery pack PH17x. Other usage
willinvalidate any approval given to this product and
may be dangerous.

B  SAFETY IN AIRCRAFT

The interference would be caused by this product
to an aircraft's navigation system and its network.
In most countries, using this product on board an
airplane is against the law.

B SAFETY FOR ENVIRONMENTS

Do no use this product in gas stations. Also the
use of this product is prohibited in fuel storehouse,
chemical plants and locations containing
explosives.

B SAFETY ON THE ROAD

Vehicle drivers in motion are not permitted to use
telephony services with the handheld device, except
in the case of emergency. In some countries, using
hand-free devices as an alternative is allowed.

B SAFETY FOR MEDICAL
EQUIPMENT

This product may cause malfunctions of medical
equipment. In most hospital or medical centers, use
of this product is forbidden.

® NON-IONISING RADIATION

This product should be operated in the suggested
normal condition only to ensure the radiative
performance and safety of the interference. As
with other mobile radio transmitting equipment,
users are advised that for satisfactory operation of
the equipment and for the safety of personnel, it is
recommended that no part of the human body be
allowed to come too close to the antenna during
operation of the equipment.
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Specifications

System Information

Processor Intel XScale CPU at 400MHz
Memory - ROM : 64MB
- RAM : 128MB

Operating System Windows Mobile™ software

Display

Type TFT-LCD 16bit, touch-sensitive, 3.5 inches

Resolution 240 x 320 at 65,536 colors

GSM/GPRS (Tri-band) Module

GSM900 880 ~ 915, 925 ~960 MHz

DCS1800 1710 ~ 1785, 18-5 ~ 1880 MHz 7

PCS1900 1850 ~ 1910, 1930 ~ 1990 MHz E =

Camera Module g =
(=

Type Color CMOS camera module g ]

Resolution VGA 480 x 640 with JPEG encoder G

Image Process - ALC (Auto Light Control)

- AWB (Auto White Balance)

Physical
Dimensions (typical) 69.9mm (w) x 130mm (h) x 19mm (1)
Weight (typical) 190g

Expansion Slots
SDIO/MMC supports Yes
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Controls and Lights

Navigation 5-way navigation pad
Buttons - 4 program buttons : Calendar, Contacts, Camera, Record
- 2 phone function : Call, End
- Volume control button (up, down)
- Power on / off
- Reset button

LED Lights - Event notification
- Charge status
- GSM/GPRS signals
Connection
Infrared SIR
1/0 port 22-pin individual port for signals (for USB, Serial, and power)
Audio Stereo headphone jack (2.59)
o g Bluetooth 1.1 compliant, power class 2
38 Audio
] Audio controller AGC
% Microphone/Speaker Built-in
Headphone WAV/WMA/MP3 stereo
Power Supply
Battery - Main : 1200mAh (typical) Li-ion Polymer removable,

rechargeable battery, data retention time : 72 hrs
- Backup : 25mAh rechargeable,
data retention time : 20 mins. (in full charge)

AC adapter - AC input / Frequency :100 ~ 240 VAC / 50 ~ 60Hz
- Rated Output : 5V / 2A DC (typical)




Pocket PC Phone User Manual

179

Troubleshooting

If you encounter any problems with your Pocket PC Phone, consult the following Trouble
Guide. If you are still having problems after reviewing these, contact Technical Support

or your dealer.

Operating Problems

Problem

Solution

® My Pocket PC Phone keeps
turning itself off.

® My Pocket PC Phone is not
making any sound.

® My Pocket PC Phone does
not vibrate when the phone
rings or alarms occur.

B Screen freezes or no re-
sponse

B Screen is blank.

Your Pocket PC Phone is designed by default to turn itself
off if not used for 3 minutes. This period can be set up to
5 minutes. Check the auto-off function on the Advanced
tab on Power setting in Chapter 5.

1 Tap =5 at the right corner of title bar to check the
volume status.

2 Check the settings of Sound and Notifications on
the Personal tab by tapping m — Settings.

1 Tap =% in the right corner of title bar to check if the
vibrate function is activate.

2 Check the setting of Sound and Notifications on
the Personal tab by tapping m — Settings.

3 Check the event note in your Calendar to see if the
Reminder has been activated.

Reset your device. See Reset your Pocket PC Phone
and clear memory section in Appendix A.

If your Pocket PC does not respond when you briefly

press the Power button, press and hold the button for a

full second. If that does not work :

1 Plug the AC power into the device to charge it.

2 Resetthe device. See Reset your Pocket PC Phone
and clear memory section in Appendix A.

[7)
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Problem Solution
B Screen is dark. 1 Check the Brightness setting by tapping [ —
Settings — System tab — Backlight — Brightness
tab.

2 Prolonged exposure to direct sunlight may also
cause your Pocket PC Phone screen to temporarily
darken. This is normal for LCD screens and is not
permanent.

B A warning message about Memory on you Pocket PC Phone is shared between
Running out of memory storage memory and program memory :
pops up on the screen. 1 Delete any unnecessary information you have
entered to release storage memory space.
2 Delete the unnecessary programs you have installed
to release program memory space.
See Managing memory section in Appendix A.

B The warning message about  Plug the AC power in to your device to charge it.
Battery low pops up on the
screen.

B Screen is hard to read, or If you are having a hard time viewing a document in
the text on the screen is too  Notes, try changing the size of the view, just tap a zoom
small for you. percentage on the Tools menu.

1 In Pocket Word and Pocket Excel, on the
View menu, tap Zoom and then select a zoom
percentage.

2 InPocket Internet Explorer, on the View menu, tap
Text Size and then select a size.

3 In Pocket Outlook data, try enlarging the display
font. To do this within Calendar, Tasks or Contacts,
tap Tools, then Options, and then select Use large
font.

Trouble
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Tapping and Writing Problems

Problem

Solution

B Device buttons do not re-
spond or bring up the wrong
program.

B Inaccurate response to stylus
taps.

B Pocket PC does not recog-
nize handwriting.

Check the Buttons setting to see if the program
assignment for each function button is set as you want.
Tap m — Settings — Personal tab — Buttons.
For detailed information about Button settings, see
Chapter 5.

Adjust the touch screen to respond more accurately to
screen taps. Tap m — Settings — System tab —
Screen — Align Screen.

For your Pocket PC to recognize your handwriting input
with the stylus, you need to use Transcriber writing. To
learn how to write in Transcriber, see Chapter 2.

ActiveSync Problems

Problem

Solution

B ActiveSync operation cannot
be performed or connected.

1 Make sure the ActiveSync cradle/cable is connected
securely.

2 Make sure you have installed the ActiveSync
software included on the Pocket PC Phone 2003
companion CD.

3 Make sure you selected Local USB or Local Serial,
as appropriate, from the Connection Settings
on ActiveSync Manager menu on your desktop
computer.

4 If you are using the optional serial cradle/cable, make
sure you are not running another program which also
works with the serial port you selected when installed.

5 IfActiveSync still doesn't work, remove the ActiveSync
software from your desktop computer then re-install
it.
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Problem Solution

B ActiveSyncis connected, but  On your desktop computer, check the Sync Options on
data or information cannot  ActiveSync Manager menu to see if the information
be transferred. type for the program you want has been selected for

synchronizing. See more detail s about synchronizing
information in Chapter 4.

Connection Problems
Problem Solution

B Unable to use Infrared (IR)  Try the following:
to transfer information. 1 Line up the IR ports so that they are unobstructed
and within a close range with 20cm.
2 Make sure nothing is between the two IR ports.
3 Adjust the room lighting. Some types of light interfere
with IR connections. Try moving to a different location
or turning off some lights.

B Cannot connect to Internet,  Try the following :
web surfing doesn't work. 1 Check that you have set up and connected to an
Internet service provider.

2 Check that your wireless connection to your mobile
service provider is switched on and the signal is un-
obstructed.

3 Verify with your Internet service provider that your
user name and password are correct.

See Chapter 7 Getting Connected. Additional

information is also available in Connections Help on the

Pocket PC Phone and ActiveSync Help on the PC.
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Problem

Solution

B Problems in cable and
cradle connection.

1

Ensure your Pocket PC Phone is turned on.
Ensure that you do not have any other active
connections . Tap — Today, and then tap
@g or 2@ at the bottom of the screen and then
Disconnect.

Ensure the cable is securely plugged into the COM
port on the back of your PC. Use the cable that came
with the Pocket PC Phone without any extra cables
or extenders attached.

Plug the other end of the cable securely into the
correct port on your Pocket PC Phone. If you are
using a cradle, push your Pocket PC Phone securely
into the cradle.
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Index
A

about 70

accessories 16
ActiveSync 62,164
activesync 22
activeSync errors 67
AC adapter converter 17
adding programs 164
add ring tone 70
album 23,154

album settings 157
annotation 137,155
auto-configuration 110
AvantGo 100

B

background 140
backing up 168
backlight 71,76
backpack 17
backup 169

back side panel 13
battery 14

Beam 106

block recognizer 27
bluetooth 102
Bluetooth Modem 107
bluetooth modes 103
bonds 104

bottom side panel 13
buttons 70,72

C

calculator 23
calendar 22,82
calibration 20
caller ID 80
call barring 80

call forwarding 80

call history 51

call waiting 80

camera 23,143

camera settings 144,150

capture button 144

cellular line 93

certificates 71

CHAP authentication 94

clear memory 169

clock 71,77

command bar 24

composition capture submode
148

conference call 47

connections 92

connect to the internet 93

contact 157

contacts 22,84

contacts information 49

converting writing 31

CSD line type 94

D

data retention 14
detailed view mode 159
device information 71
device settings 70

dialer screen 38

drawing on the screen 32

E

E-mail 156

e-mail attachments 167
e-mail service 110
earphone jack 13

editing text 29

emergency call 58

entering information 25,129

European Union notice 172

F

FCC compliance 173
file formats 142

find 34,86

front side panel 12
full reset 170

G

games 23
general precautions 174
GPRS settings 94

H

health and safety information
174

image capture submode 145
in-call options 46

inbox 22,110

indicators 21,38

infrared connection 66
infrared port 13

input 70,72

input panel 26

installing ActiveSync 62
international call 58

K

keypad lock 59
keypad tone 79
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L

LED 13
left side panel 12
letter recognizer 27

M

making calls 42
Media Player 133
memory 71,77,166
memory card 168
menus 70,73
messages 110
microphone 12
microphone AGC 71
Microsoft Reader 22,133
MMS 23,119,156
mobile favorites 97,98
MSN 116

MSN Messenger 22

N

navigation nar 24
navigation pad 12,39
network 80

notes 22,89
notifications 25
notification LED 13

(0

orientation toggle 144
owner information 70,74

P

PAP authentication 94
password 70,74

permanent save 71
Personal 70

phone 22,36,70
phone lock 59
phone security 58
phone settings 78
phone volume 41
photo contacts 23,53
photo ID 53

pictures 23,138

PIN 39

pocket Excel 22,131
pocket IE 22,96
pocket Word 22,128
pop-up menus 24
power 71,78
programs 22
punctuate in transcriber 28

R

re-calibration 20
receiving e-mail 112
recharge 15
recording 33
regional settings 71
regulatory notice 171
remove programs 71
removing programs 164
reset 169

RF exposures 173
right side panel 13
ring tone 79

ring tones 156

ring type 79

S

safety precautions 174
SAR information 175
screen 71

SD and MMC cards 168
secure your phone 58
services 80

SIM card 36

SIM card lock 60

SIM manager 23,45,50
slide show 158,161

SMS 64,115

soft keyboard 26

soft reset 12,170

sounds 79

sounds and notifications 70,75
speakerphone mode 48
specifications 177

speed dial 44

stereo headset 17
storage card 166
synchronizing 112
synchronizing calendar 65
synchronizing contacts 65
synchronizing inbox 64
synchronizing tasks 65
sync connector 13

T

tasks 22,87

template 149

terminal services client 101
thumbnail view mode 154
today 70,75

today screen 20

today wallpaper 140,160
top side panel 12
transcriber 28
troubleshooting 179
turning phone on and off 40

U

USB/Serial Cradle 16




186 Pocket PC Phone User Manual

USB/Serial sync cable 17

Vv

vibrate mode 41
video capture submode 147
voice mail 49

w

WAP gateway 95
Windows Media Player 22
wireless modem 23,102
writing on the screen 30

X

xBackup 23,169

V4

zooming in/out 146



